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Safety Information

Warning! Do not remove or insert diagnostics cable while circuit is live.

Warranty
FreeWave Technologies, Inc. warrants your FreeWave® Wireless Data Transceiver against defects in materials and
manufacturing for a period of two years from the date of shipment, depending on model number. In the event of a
Product failure due to materials or workmanship, FreeWave will, at its discretion, repair or replace the Product. For
evaultation of Warranty coverage, return the Product to FreeWave upon receiving a Return Material Authorization
(RMA).

In no event will FreeWave Technologies, Inc., its suppliers, or its licensors be liable for any damages arising from
the use of or inability to use this Product. This includes business interruption, loss of business information, or other
loss which may arise from the use of this Product. OEM customer’s warranty periods can vary.

Warranty Policy will not apply in the following circumstances:

1. If Product repair, adjustments, or parts replacements are required due to accident, neglect, or undue
physical, electrical, or electromagnetic stress.

2. If Product is used outside of FreeWave specifications as stated in the Product's data sheet.

3. If Product has been modified, repaired, or altered by Customer unless FreeWave specifically
authorized such alterations in each instance in writing. This includes the addition of conformal coating.

Special Rate Replacement Option
A special rate replacement option is offered to non-warranty returns or upgrades. The option to purchase the
replacement unit at this special rate is only valid for that RMA. The special replacement rate option expires if not
exercised within 30 days of final disposition of RMA.

Restricted Rights
Any product names mentioned in this manual may be trademarks or registered trademarks of their respective
companies and are hereby acknowledged.

This manual is for use by purchasers and other authorized users of FreeWave products.

No part of this manual may be reproduced or transmitted in any form or by any means, electronic or mechanical, or
for any purpose without the express written permission of FreeWave Technologies, Inc. FreeWave reserves the
right to make changes to this manual without notice. FreeWave assumes no responsibility or liability for the use of
this manual or the infringement of any copyright or other proprietary right. 
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Document Revision History

Date Rev Letter Updates Made

03/02/2012 C Added information about not using the Network Diagnostics application to
poll multiple networks at a time, or a single network continuously, along with
other best practices. For more information, see "Network Diagnostics
Application" on page 43 and "Network Diagnostics Best Practices" on page
44.

12/22/2011 B Added information about data backups, a new feature in version 2.8.5. For
more information, see "Data Backups" on page 9.

08/02/2011 A Added documentation for the following new features in version 2.8:

l Using the new Modbus Interface application and the pre-defined register
maps tomonitor devices that use theModbus protocol. "Modbus Interface
Application" on page 85

l Exporting a network to a SQL Server database. See "Exporting Networks"
on page 16.

l Tool Suite 2.8 requires SQL Server Compact 3.5 Service Pack 2. See
"Installing and Upgrading Tool Suite Software" on page 1.

Updated document organization and structure:

l The document now contains a Preface and an Introduction chapter that
explains the Tool Suite navigation components.

l Each application in Tool Suite is now contained in its own chapter.
l Sections are now task oriented for improved readability and use.
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Preface

FreeWave Tool Suite is a program that provides easy, reliable, and repeatable programming andmonitoring
tools for FreeWave Technologies, Inc. wireless data transceivers, I/O Serial Base devices, and Expansion
Modules. The following applications are available from within Tool Suite:

l Configuration - Use this application to program devices according to specific network
requirements.

l Network Diagnostics - Use this application to view performance data in real-time from your
network.

l Local Diagnostics - Use this application to view a real-time snapshot of MultiPoint setups that
measure the signal-to-noise level of a device .

l Spectrum Tool - Use this application tomonitor the ambient noise at various points in the
spectrum as a serial device hops through them. The Spectrum Tool is available for 900MHz, 2.4
GHz, and 1.3 GHz serial devices only.

l Setup Terminal - Use this application to configure device using a terminal window. The Setup
Terminal applicationmirrors themenu structure you would see if you were using HyperTerminal.

l Modbus Interface - Use this application tomonitor and test register map values on any device
that uses aModbus interface.

l CP Data Logger - Use this application to review basic polling and reporting for FreeWave
Cathodic Protection RemoteMonitoring Units.

l Updates - Use this application to review the changes in the latest version of Tool Suite and to
ensure that you are running the latest version.

This document covers how to use the Tool Suite and the applications within it including the following:

l Instructions to install Tool Suite and the components required to run it.

l Descriptions of the navigation features used across Tool Suite applications.
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l Details about defining networks, which are used across the applications in Tool Suite.

l Instructions to use the features in each application available in the Application pane.

For information about configuration settings for each FreeWave device, see that device's user manual or
addendum. For information about what is new in the latest versions of Tool Suite, click Updates in the
Application pane within Tool Suite. The additions to each release are listed on the initial page.

Notational Conventions
This guide uses the following notational conventions:

l Bold - Indicates items that you select, parameter settings, and parameter names.

l Warning! - Indicates a situation that might cause damage to your radio, data, or network.

l - Provides time saving or informative suggestions about using the product.

Contacting FreeWaveTechnical Support
For up-to-date troubleshooting information, check the Support page at www.freewave.com.

FreeWave provides technical support Monday through Friday, 7:30 AM to 5:30 PMMountain Time (GMT -7).
Call toll-free at 1.866.923.6168, within Colorado call 303.381.9200, or contact us through email at
moreinfo@freewave.com.

Documentation Feedback
Your feedback is important to us! FreeWave Technologies, Inc. is committed to continually improving the
quality of our documentation. If you have any comments or suggestions about this document, send them to us
at techpubs@freewave.com. Please include the title of the document or the document's part number in your
email.
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Chapter 1: Introduction to Tool Suite

Tool Suite consists of applications that you can use to configure devices and run diagnostics to determine
how well the devices in your network are performing. Each application is described in detail in its own chapter
in this document.

This chapter discusses the following:

l Installing and updating Tool Suite.

l Using the navigation components that are common throughout the applications available within
Tool Suite.

l Connecting to a device from within Tool Suite.

As you work in Tool Suite, the changes youmake are saved automatically. However, if you aremaking
changes to radio settings, the changes are not made on the device until you choose to send them to the
device. For more information, see "Programming Devices" on page 28.

Installing and Upgrading Tool Suite Software
Tool Suite is compatible with the following operating systems:

l Windows 2003 Service Pack 1

l Windows XP Service Pack 2

l Windows Vista

l Windows 7 or higher

Before installing the Tool Suite software, ensure that your computer has the following required components:

l Microsoft SQL Server CE Service Pack 2

l Microsoft .NET framework version 3.5
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Both components are available from the FreeWave customer support site at www.freewave.com and are
included in the Tool Suite install available on the FreeWave UserManual and System Tools CD. If .NET,
Microsoft SQL Server, andMicrosoft Report Viewer 2008 are not detected when initializing the Tool Suite
installation setup from the CD, these programs are downloaded and installed automatically and require an
Internet connection during the installation.  This process may take several minutes for each to program install.

Note: To gain access to the FreeWave customer support Web site, create your own
login using the onscreen instructions on theWeb page.

Installing Microsoft SQL Server
Youmust haveMicrosoft SQL Server CE Service Pack (SP) 2 installed on the computer on which you want to
install Tool Suite. The installation file is available for download from the customer support site at
www.freewave.com or from the FreeWave UserManual and System Tools CD.

1. Do one of the following to launch the installer:

l If you need to install Microsoft SQL Server CE SP 2, Microsoft .NET, and the Tool Suite
application, login to the FreeWave customerWeb site, select Software, and double-click the
FreeWave Tool Suite Web Install link to launch the installer. 

l If you need to install only Microsoft SQL Server CE SP 2, login to the FreeWave customerWeb
site, select Software, and double-click theMicrosoft SQL Server SP 2 Link to launch the
installer.

l If you are using theUserManual and System Tools CD, insert the CD-ROM into the CD drive
on your computer. If AutoPlay is enabled, the CD contents automatically launches. Otherwise,
double-click FW Utilities CD inWindows Explorer. In themainmenu click Software. Click
Install Tool Suite to launch the installer.

2. Click Next to begin theMicrosoft SQL Server Compact setup and installation.

3. Read the license agreement and select I accept the terms of the license agreement if you
agree with the terms. Click Next continue with the installation or click Cancel to exit.
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4. After the setup is complete, click Install to begin the installation.

5. After the installation is complete, click Finish to exit and continue with installing theMicrosoft
.NET framework.
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Installing the Microsoft .NET Framework
If you are running the Tool SuiteWeb install or are installing Tool Suite from theUserManuals and System
Utilities CD, theMicrosoft .NET Framework installation starts after you install Microsoft SQL Server.

1. Login to the FreeWave customerWeb site, select Software.

2. Double-click theMicrosoft .NET Framework link to launch the installer.

3. Read the license agreement and select I accept the terms of the license agreement if you
agree with the terms. Click Install to continue with the installation or click Cancel to exit.

4. After the installation is complete, click Exit to exit and continue with installingMicrosoft Report
Viewer.
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5. Click Next to continue with the installation orCancel to exit.

6. Read the license agreement and click I have read and accept the license terms if you agree
with the terms. Click Install to continue with the installation or click Cancel to exit.
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7. After the installation is complete, click Finish to exit and continue with the Tool Suite installation.
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Installing the Tool Suite Application
After the required components are installed on your computer, you can install the Tool Suite application. The
installation adds a shortcut icon to your desktop.

1. Do one of the following to launch the Tool Suite installer:

l Login to the FreeWave customerWeb site, select Software, and double-click the FreeWave
Tool Suite CD Install link to launch the installer. 

If you need to install bothMicrosoft SQL Server CE SP 2 andMicrosoft .NET Framework,
double-click the FreeWave Tool Suite Web Install link.

l If you are using theUserManual and System Tools CD, insert the CD-ROM into the CD drive
on your computer. If AutoPlay is enabled, the CD contents automatically launches. Otherwise,
double-click FW Utilities CD inWindows Explorer . In themainmenu click Software. Click
Install Tool Suite to launch the installer.

2. In theWelcome to FreeWave Tool Suite SetupWizard window, click Next to continue with the
installation.

3. Select the setup you want to run and click Next.

If this is the first time you are installing Tool Suite on your computer, select Complete.
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4. Click Install to proceed with the installation or click Back to change the Setup Type orCancel to
exit.

5. After the installation is complete, click Finish to exit and launch FreeWave Tool Suite. 
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Data Backups
As you work in Tool Suite, the items you create, such as networks and radio templates, are saved in the
ToolSuite.sdf file. In version 2.8.5, you can create a backup copy of this file and save it to any location on your
computer or network. Backing up your data ensures that you always have a copy of your network and device
settings in the event of a computer malfunction.

Tool Suite prompts you to create a data backup seven days after the last backup was completed.

After you have upgraded to version 2.8.5, any future upgrades make an automatic backup copy of your
ToolSuite.sdf (all Configuration application data), ModPoller.sdf (all Modbus Interface data), and cprmu.sdf
(all CP Data Logger data) files in the the C:\Program Files\FreeWave Technologies\Freewave Suite\backups
directory.

To back up your Tool Suite data manually:

1. From the File menu, select Back Up Data to display the Select Backup File dialog box.

2. Navigate to the directory where you want to save the backup file.

By default, the system displays the C:\Program Files\FreeWave Technologies\Freewave
Suite\backups directory and the file name is ToolSuite.sdf<date and time stamp>.bak. FreeWave
recommends accepting the default file name.

3. Click Save to save the file.

Note: You cannot manually back up data from theModbus Interface or CP Data
Logger applications within Tool Suite at this time.

To restore Tool Suite data from a backup copy:

Note: Restoring data from a backup copy completely replaces the current Tool Suite
data with the data in the backup file. FreeWave recommends saving a backup
copy of the current Tool Suite data prior to restoring from a backup.

1. InWindows Explorer, go to C:\Program Files\FreeWave Technologies\Freewave Suite\backups
and locate the ToolSuite.sdf<date and time stamp>.bak file with the date and time stamp from
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which you want to restore data. This may not be the file with the latest date and time stamp.

If you have backed up datamanually to another location, go to that location to locate the file.

2. Rename the file to ToolSuite.sdf

3. Copy the renamed file to the C:\Program Files\FreeWave Technologies\Freewave Suite\data
directory.

4. Open Tool Suite.

Your data from the copied file is read into the application.

To restoreModBus Poller or CP Data Logger data, locate theModPoller.sdf.bak or the
cprmu.sdf.bak file from the C:\Program Files\FreeWave Technologies\Freewave Suite\backups,
delete the.bak extension from the file name, and copy the file into the C:\Program Files\FreeWave
Technologies\Freewave Suite\data directory.

Tool Suite Navigation
The buttons, ribbons, and toolbars in Tool Suite help you to navigate to different portions of the application. In
addition, options are available using the right-click and left-click buttons on your computer mouse. The
following sections describe the navigation tools available in the application and when to use each.

Recommended Computer Display Settings
When running Tool Suite, to achieve optimal visual performance set the computer’s desktop display settings
to the following recommended settings. Depending on your system setup, Administrative rights to the
computer may be required tomake these changes.

l Minimum resolution - 1024 x 768

l DPI - 96.

A DPI setting of 120 is not supported (graphics may not align and some text may be partially
hidden).

Ribbons and Toolbars
Ribbons refer to the toolbars that have either the FreeWave logo on them or the title bars underneath that
display the network name.  The sections used to group buttons with like functionality together on these
ribbons are specific to the application you have open within Tool Suite.

Note: The terms “ribbon” and “toolbar” are used interchangeably throughout this
manual.

Below themain ribbon is a Network Title ribbon that displays the name of the network that is currently
selected.  This ribbon only displays in the Configuration, Network Diagnostics, and CP Data Logger
applications and includes additional options that apply to those applications.
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Network Title ribbon in the Configuration application:

Network Title ribbon in the Network Diagnostics application:

Network Title ribbon in the CP Data Logger application:

Minimizing or Maximizing the Ribbon
You canminimize the ribbon at the top of the window tomaximize the viewing space within the application.
Minimizing the ribbon applies to the application you are currently viewing. When you switch applications, the
ribbonmaximizes for that application.

1. Click the arrow button above the File menu.

If youmoved theQuick Access Button to below the ribbon, the arrow buttonmight be located
below the ribbon or the Filemenu.

2. SelectMinimize the Ribbon.

If themenu option displays with a check mark next to it, the ribbon is already minimized. Select
the option tomaximize the ribbon.

You can alsominimize the ribbon using the ribbon toggle button located above the FreeWave logo.

When the ribbon is minimized, the tab still displays. Click once on the tab tomaximize the ribbon
The ribbon displays until you click anywhere outside the ribbon.

File Drop-DownMenu
The File drop-downmenu in themain ribbon functions similar to a File menu inmost Windows software
programs.
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Access the following functionality from the File drop-downmenu:

l Hide Applications - Shows or hides the Application pane that displays on the left side of Tool
Suite.

l Back Up Data - Allows you to save a backup copy of the ToolSuite.sdf file, which contains all
your Tool Suite data. For more information, see "Data Backups" on page 9.

l Help > About - Displays the Tool Suite software version information.

l Help > User Manual - Opens an Adobe PDF version of the latest Tool Suite user manual. Adobe
Acrobat Reader is required to read this file. You can download Adobe Acrobat Reader for no charge
at www.adobe.com.

l Exit - Closes Tool Suite.

Field Tool Tips
Hold themouse curser over a setting to display a brief description about that parameter's function .

Note: This feature does not apply to I/O Expansionmenus.

Accessing Individual Device Options
A device's options depends on its operationmode, for exampleMaster or Slave. To access specific options
for a device in places such as the Device tree in the Configuration application, right-click the device. 
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Chapter 2: Network Files and Settings

The devices that you use exist in a network, that is, devices are connected to each other to communicate with
one another. In Tool Suite, you can set up the devices that you program andmonitor using networks that
mirror the devices you have setup in your actual network. You can group devices into serial, TCP Terminal
Server, and Ethernet networks. Networks can be setup by geographic region, by customer, or whatever
grouping that helps you to identify the devices.

Each network has its own set of devices and configuration settings to connect to the devices within it.

The following applications within Tool Suite use networks:

l Configuration - Networks defined in this application are shared with the Network Diagnostics
application. For more information, see "Creating Configuration and Network Diagnostics
Networks" on page 13.

l Network Diagnostics - Networks defined in this application are shared with the Configuration
application. For more information, see "Creating Configuration and Network Diagnostics
Networks" on page 13.

l CP Data Logger - Typically you have only one CP network that you define the first time you use
the CP Data Logger application. For more information, see "Configuring CP Data Logger Network
Settings" on page 73.

l Modbus Interface - Typically you have only oneModbus Interface network that you define the first
time you use theModbus Interface application. For more information, see "ConfiguringModbus
Network Settings" on page 86.

Creating Configuration and Network Diagnostics Networks
Setup a network prior to configuring serial or Ethernet devices in the Configuration application or running
diagnostics in the Network Diagnostics application. Tool Suite supports multiple networks and network types
that can run simultaneously.
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Note: The TCP terminal server network is only useful in the Network Diagnostics
application where you want to gather diagnostics of a serial network through a
TCP/IP connection to a terminal server.

To create a network for use in theModbus Interface application, see "ConfiguringModbus Network Settings"
on page 86.

To create a network tomonitor in the CP Data Logger application, see "Configuring CP Data Logger Network
Settings" on page 73.

To create a serial network:

1. In either the Configuration application or the Network Diagnostics application, click Add in the
Datastore section of the ribbon to display the Add Network window.

2. In theNetwork Name field, enter a name that identifies the network's purpose.

3. (Optional) In theCompany field, enter a company name associated with the network.

4. Click Next.

5. From theNetwork Type drop-down list, select Serial.

6. If you are creating a network in the Configuration application, click Finish to save the network to
the database.

If you are creating a network in the Network Diagnostics application, click Next and continue with
the next step.

7. In theAre you using 1.4 GHz field, select Yes if there are any 1.4 GHz devices in your network.
If there are not, leave the field set toNo.

8. In theCom Port field, select the port to which the device is connected and click Next.

9. Click Finish to save the network to the database.

10. For additional network options, see "Configuring Network Settings" on page 19.

To create a TCP Terminal Server network:

1. In either the Configuration application or the Network Diagnostics application, click Add in the
Datastore section of the ribbon to display the Add Network window.

2. In the Network Name field, enter a name that identifies the network's purpose.

3. (Optional) In theCompany field, enter a company name associated with the network.

4. Click Next.

5. From theNetwork Type drop-down list, select TCP Terminal Server.

6. If you are creating a network in the Network Diagnostics application, click Next and continue with
the next step.

7. In the IP Address field, enter the IP address of the terminal server used to read the network.

8. In thePort field, enter the port number on the terminal server used to read the network and click
Next.

9. Click Finish to save the network to the database.

10. For additional network options, "Configuring Network Settings" on page 19.
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To create an Ethernet network:

1. In either the Configuration application or the Network Diagnostics application, click Add in the
Datastore section of the ribbon to display the Add Network window.

2. In theNetwork Name field, enter a name that properly identifies the networks purpose.

3. (Optional) In theCompany field, enter a company name associated with the network.

4. Click Next.

5. From theNetwork Type drop-down list, select Plus Ethernet.

6. If you are creating a network in the Configuration application, click Finish to save the network to
the database.

If you are creating a network in the Network Diagnostics application, click Next and then
click Finish to add the network to the database.

7. For additional network options, "Configuring Network Settings" on page 19.

Importing Networks
If you have a FreeWave network file that was exported from Tool Suite, you can import the content of that
network. You can import the following file types:

l FreeWave Network File (.fwn) - A file that was exported from Tool Suite versions 2.2 and above.

l FreeWave Network Design (.fwt) - A file that was exported from the Network Design tab.

l FreeWave Data File (.sdf) - A file that was exported from Tool Suite version 2.0.1.2 and before.

l EzConfig File (.fws) - A file that was exported from the FreeWave EZConfig application, which
preceded Tool Suite.

l Comm Control File (.nwf) - A network design file that was exported from the FreeWave Comm
Control application, which preceded EZConfig and Tool Suite.

l Comma Separated Value (.csv) - A comma separated values (.csv) file saved from a
spreadsheet application such as Microsoft Excel. These files must be formatted Serial Number,
Name, and if applicable, IP Address.  If the file is not in this format, you receive an error when
importing the file.

Ethernet networks only have the option to import Tool Suite .fwn and CommaSeparated Value .csv file
types.

1. In either the Configuration application or the Network Diagnostics application, click Import in the
Datastore section of the ribbon to display the Add Network window.

2. From theOptions drop-downmenu in Network Title ribbon, select Import and select the file type
to import.

You can also select Import from the Datastore section of the ribbon to import a Tool Suite version
2.2 and above file type (.fwn).

3. In the Import window, locate the file you want to import and click Open to import the file.

Tool Suite processes the file and displays it.
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You can now access the network from both the Configuration and Network Diagnostics
applications.

Exporting Networks
Use the Export functions to save a network data for transferring to a different Tool Suite instance, or for
viewing in a spreadsheet or database.

Note: If you havemultiple networks that you want to export, youmust export each
network individually.

You can export the data in a network in Tool Suite to one of the following:

l FreeWave Network File (.fwn) - In the Configuration application, exports the settings for the
discovered and template devices in a network that you can import into another Tool Suite
instance. You can also use this option if you want to make a copy of a network file and then import
it to use as a base for a different network.

In the Network Diagnostics application, exports the network file, the historical diagnostic data, and
the Path View into the network.

Using an exported network configuration file, you can:

l Load an existing radio configuration when you add radios to an existing network.

l Reload the configuration of any radio in the network when replacing a failed or damaged radio.

l Send your exact network configuration to someone for review or troubleshooting.

l Ensure the network configuration is always available at theMaster radio site. If you need to
program a radio in the network, you have the needed configuration files at hand.

l Ensure you always have a saved version of the latest configuration settings for your network.

l Network Settings Report (.csv) - In the Configuration application, exports the settings for the
discovered devices in your network to a file that you can open in a spreadsheet application such as
Microsoft Excel.

In the Network Diagnostics application, exports the network file, the historical diagnostic data, and
the Path View information to a file that you can open in a spreadsheet application such as
Microsoft Excel.

Viewing your network data in a spreadsheet can offer better clarity about settings across the
network.

l FreeWave Network Design (.fwt) - Exports the virtual network map in the Network Design tab of
the Configuration application that you can import into another Tool Suite instance. You can also
use this option if you want to make a copy of a Network Design and then import it to use as a base
for a different network.

You can export a Network Design file from the Configuration application.

l SQL Server Database - Exports network data to the SQL Server database of your choice. You
must have Read/Write permission to the server, and the server must be accessible to Tool Suite.

You can export a network to a SQL Server database from the Configuration, Network Diagnostics,
and CP Data Logger applications.
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To export a FreeWave Network:

1. In either the Configuration application or the Network Diagnostics application, select the network
you want to export from the Networks section of the ribbon.

2. From theOptions drop-downmenu in the Network Title ribbon, select Export > FreeWave
Network File.

You can also right-click in an empty area in the tree view and select Export > FreeWave Network
File.

3. If you are exporting a network file from the Network Diagnostics application, enter the date range
for which you want to include historical diagnostic data in the export and click Export.

For example, if you want to see historical data for the last month, enter the first and last days of
that month in the corresponding fields.

To complete the export without any historical diagnostic data, select the Exclude Diagnostic
History check box and click Export.

4. In the Export Network window, select the directory location to where you want to save the file.

5. In the File name field, enter the file name and click Save.

The file is saved in the directory location with a .fwn extension.

To export a Network Settings Report:

1. In either the Configuration application or the Network Diagnostics application, select the network
you want to export from the Networks section of the ribbon.

2. From theOptions drop-downmenu in the Network Title ribbon, select Export > Network
Settings Report.

You can also right-click in an empty area in the tree view and select Export > Network Settings
Report.

3. In the Export Network window, select the directory location to where you want to save the file.

4. In the File name field, enter the file name and click Save.

The file is saved in the directory location with a .csv extension and opens the default application
you have set to open .csv files on your computer.

To export a FreeWave Network Design:

1. In the Configuration application, select the network you want to export from the Networks section
of the ribbon.

2. From theOptions drop-downmenu in the Network Title ribbon, select Export > FreeWave
Network Design.

You can also right-click in an empty area in Network Design and select Export > Design.

3. In the Export Network window, select the directory location to where you want to save the file.

4. In the File name field, enter the file name and click Save.

The file is saved in the directory location with a .fwt extension.
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To export a network to a SQL Server database:

1. In either the Configuration application or the Network Diagnostics application, select the network
you want to export from the Networks section of the ribbon.

In the CP Data Logger application, there is only the network.

2. From theOptions drop-downmenu in the Network Title ribbon, select Export > SQL Server DB.

You can also right-click in an empty area in the tree view and select Export > SQL Server DB.

3. In the Database Connection Form window, complete the following information about the SQL
Server database to which you want to save the network data:

Field Description

Database
Server

Enter the location of the server that runs the SQL database to
which you want to save the network data. This databasemust be
within your IT network and the computer on which you are working
must have access to the location.

Database
Name

(ReadOnly) The network data is saved to a table in the SQL
Server database called FreeWaveNetwork. If you are exporting
from the CP Data Logger application, the network data is saved to
a table called FreeWaveCPData.

If the the table already exists in your database, when you export,
Tool Suite adds lines to the existing table.

Use Windows
Authentication

Select this check box to use yourWindows user name and
password to access the SQL Server database. If your database
access credentials are different from yourWindows user name
and password, leave this check box unseleted and use theData
User Name andPassword fields.

Database User
Name

Enter the user name you use to access the server in theDatabase
Server field.

Password Enter the user password you use to access the server in the
Database Server field.

4. Click Test Connection to ensure you have access to the database and that the user name and
password you entered are correct.. 

If Tool Suite can connect to the database, you receive a Success message. If Tool Suite cannot
connect to the database you entered, you receive an error message. Verify that the information
you entered in the Database Connection Form window is correct and that the server is running and
test the connection again.

5. Click OK to export the network data to the SQL Server database.

Deleting Devices From Networks
You can remove the devices from a defined network without deleting the network and the network settings.
You can also deletes all device and settings associated with a network, the network name, and any stored
diagnostic data.
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To remove an individual device from a network:

1. In either the Configuration application or the Network Diagnostics application, select the network
you want to change from the Networks section of the ribbon.

2. Right-click in an empty area in the tree view and select Delete.

Click Yes at the prompt to delete the device from the network or click No to continue without
clearing the device from the network.

To remove all the devices from a network:

1. In either the Configuration application or the Network Diagnostics application, select the network
you want to change from the Networks section of the ribbon.

2. From theOptions drop-downmenu in the Network Title ribbon, select Clear Network.

You can also right-click in an empty area in the tree view and select Clear Network.

Click Yes at the prompt to remove all the devices from the network or click No to continue without
clearing the devices network.

To delete a network:

1. In either the Configuration application or the Network Diagnostics application, select the network
you want to delete from the Networks section of the ribbon.

2. From theOptions drop-downmenu in the Network title ribbon, select Remove Network.

You can also right-click in an empty area in the tree view and select Remove Network.

Click Yes at the prompt to remove the network and all its data from Tool Suite or click No to
continue without deleting the network.

Configuring Network Settings
(For Configuration and Network Diagnostics Applications)

Before you connect to devices in a network, define the network's settings. The network settings provide Tool
Suite with the information it needs to connect to the devices in the network.

Networks in theModbus Interface and CP Data Logger applications also have network settings. For more
information, see "ConfiguringModbus Network Settings" on page 86 and "Configuring CP Data Logger
Network Settings" on page 73.

1. In either the Configuration application or the Network Diagnostics application, select the network
for which you want to configure settings from the Networks area in the ribbon.

2. From theOptions drop-downmenu in the Network Title ribbon, select Network Settings to display
the Network Settings window.

3. Complete the following settings for the network:

Field Description

Name Enter an identifying name for the network. If this field is left
blank, the network name is Default Network.
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Field Description

Company (Optional)Enter the company name associated with the
network. 

Interface Enter the network type (serial or TCP). If you are setting a
serial or TCP network also set the COM port, or whether 1.4
GHz radios are in use in the Network. Make the necessary
changes and click Update in the Change Interface window
before returning to the Network Settings window.

Polling Interval (ms) Enter the amount of time Tool Suite waits between each
time it pools the radios. The default Polling Interval for Serial
and TCP/IP networks is 200 ms and to 500 ms for Ethernet
networks. See the section below for recommended polling
intervals based on whether serial Repeaters are used in a
network.

To poll automatically when a polling interval has completed,
select theAuto check box.

Polling Mode Select from one of the following pollingmodes:

l Discovery - During the first diagnostic run of a new
network, to discover radios more quickly, set the polling
mode toDiscovery to allot 9 out of 10 polls to discovering
new radios in the network, and 1 out of 10 polls to
populating settings information.

This is the default mode when a new network is added.
Discoverymode is not available for Ethernet networks.

l Sequential - After all radios have been discovered in the
network, change toSequential mode. This mode allots 1
out of 10 polls to discovering new radios, and 9 out of 10
polls to populating settings information.

Clear Diagnostics
After

Select the amount of time Tool Suite waits before clearing
data for the specified network.

To keep the history data intact, select theExclude History
check box.

Notes Enter any additional information about the network that is
not highlighted in the settings.

4. Click Update to change the network settings or click Cancel to exit without updating the settings.

Recommended Polling Intervals
The default Polling Interval field setting is 200ms for serial and TCP/IP networks, and 500ms for Ethernet
networks. The table below provides recommended polling intervals based on whether your network includes
serial Repeaters.
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Network
Type

Default
Polling
Interval

Minimum
Polling
Interval

Repeaters
turned OFF in

Master
1 Repeater
(add 50 ms)

2 Repeaters
(add another

50 ms)

For each
additional
Repeater,
continue
to add
50 ms

Serial 200ms 100ms 100ms 150ms 200ms 250ms

TCP/IP 200ms 100ms 100ms 150ms 200ms 250ms

Ethernet* 500ms 100ms 100ms 150ms 200ms 250ms

455MHz 200ms 300ms 300ms 600ms 600ms Not
supported

* In Ethernet networks, customer data is not given polling priority over diagnostic data.

Viewing Networks
You can view a single network at a time. When you open a network to view in one application, that network is
also displayed in the other applications that use networks. For example, if you open Network A in the
Configuration application, if youmove to the Network Diagnostics application, Network A is open and
displays in that application as well.

To select a network to view:

1. In either the Configuration application or the Network Diagnostics application, click the drop-down
list in the Networks section in the ribbon.

2. Select the network you want to view.

Networks are grouped intoSerial andPlus (Ethernet) groups.

The selected network displays in the application.

Connecting Radios to a Computer
To read and program a radio using Tool Suite, you need to connect the radio to a desktop computer or a laptop
that runs the Tool Suite software.

1. Connect a serial or diagnostic cable between the computer or laptop and the radio. Using a
diagnostic cable is recommended.

2. Connect the power supply and turn on the radio.

Note: You can use a serial cable for both Configuration and Setup Terminal
applications; however, a Diagnostics cable is required to run diagnostics using
the Network or Local Diagnostics applications. Also, for Diagnostics only,
functionality is available via TCP/IP if routing through a Terminal server to reach
the serial master radio.
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Chapter 3: Configuration Application

Use the Configuration application to program parameters on devices in your network. From the Configuration
application you can do the following:

l Define templates that contain the settings to send to a device.

l Create Network Design diagrams that are a virtual version of your device network.

l Program device settings including resetting a device to its factory default settings.

l Upgrade to the latest version of firmware available for a device.

Click Configuration in the Applications pane to get started.
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About the Devices Tree
Tool Suite maintains a database of all radios that are read, programmed, or in someway manipulated in the
software. This database allows you to check settings for a defined device without being connected to the
device. You can view the devices stored for a selected network in the Devices tab. The devices in the
network display in a tree format, similar to files and folders in directories display inWindows Explorer.

In the Devices tab, devices are grouped into one of the following views:

l Discovered Devices - Lists devices that have a serial number and are found when the device is
read through the Network Diagnostics application or programming devices in the Configuration
application.

l Template Devices - Lists any radio createdmanually through the template wizard and EZConfig
imported files.

To change between the two views, click the corresponding accordion button at the bottom of the pane. To hide
or show the accordion buttons, click the arrow at the bottom of the window pane and select which buttons to
hide or show. 
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After Tool Suite successfully reads a device (after you click Read Radio orRead Serial Base), the list
updates to include the read device’s serial number, name, and a symbol to indicate the operationmode. 

l - Indicates aMaster in the network.

l - Indicates a Slave in the network.

l - Indicates a Repeater in the network.

l - Indicates a Serial Base in the network.

Tool Suite also refreshes the right side of the window to display the selected device's settings. Selecting a
device listed in the Discovered Devices or Templates view refreshes the Device Information and other
settings for that selection.

Adding Template Devices to the Network
Use templates to define a device in your network. You can define the settings for the template, and use that
template to program all the radios in your network with that configuration. Templates save you from having to
define each individual device in your network if the devices share the same settings, and helps to ensure that
devices that require the same settings across your network are programmedwith the same settings.
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You can add a template for a device to the Device tree which adds it to the network database for any network
type. The device is added with the factory default settings. This feature functions as a single radio template
and is added to the Template Devices view in the Device tree.

To add a radio template to the Device tree:

1. Click Configuration in the Applications pane to display the Configuration application.

2. In the Networks section of the Configuration ribbon, select the network to which you want to add a
device.

3. Right-click in a blank area of the Device tree and select Add > Radio Template.

4. In theName field, provide a name that helps identify this device.

5. From theRadio Type drop-down list, select the type of device you want to add to your network.

The lists includes all the supported devices for the network type.

6. Click Add to add the device to the Device tree orCancel to exit without adding the device.

To add a serial base template to a serial network Device tree:

1. Click Configuration in the Applications pane to display the Configuration application.

2. In the Networks section of the Configuration ribbon, select the network to which you want to add a
device.

3. Right-click in a blank area of the Device tree and select Add > Serial Base Template.

4. In theName field, provide a name that helps identify the base.

5. From theModule Type drop-down list, select the type of serial base you want to add to your
network.

6. Click Add to add the device to the Device tree orCancel to exit without adding the device.

Organizing Devices in Folders in the Device Tree
If your network contains a larger number of devices, you can use folders in the Device tree to help organize
the devices in the network. For example, youmight create folders to store like devices together, or youmight
choose to organize the network by geographic region.

1. Click Configuration in the Applications pane to display the Configuration application.

2. In the Networks section of the Configuration ribbon, select the network to which you want to add a
folder to the Device tree.

3. Right-click in a blank area of the Device tree and select Add > Folder.

A new folder is added to the tree.

3. Right-click the folder in the tree and select Rename and enter a name that describes the content of
the devices in the folder.

4. Tomove the folder in the tree, select the folder and drag and drop it to the correct location in the
tree.

5. Tomove devices in to the folder, select the device and drag and drop it onto the folder.
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Filtering Devices in the Device Tree
If you have a large network and only want to see devices in the tree of a certain modemmode you can filter the
contents of the tree to display only those devices. For example, if you only want to see theMaster devices.

You can also filter devices in the Network Design view.

1. Click Configuration in the Applications pane to display the Configuration application.

2. In the Networks section of the Configuration ribbon, select the correct network.

3. From the Filter menu in the Network Title ribbon, select the device type to display.

To display all the devices, select Show All.

Reading Current Settings From a Device
You can poll a device for its current parameter settings. Upon a successful read of a device, the Device tree
updates to include the device’s serial number, name, and a symbol to indicate the operationmode. Tool Suite
also refreshes the right side of the window displaying the device settings. Selecting a device listed in the
Discovered Devices or Templates view refreshes the Device Information and other settings for that device.

If an older version of firmware is loaded that Tool Suite does not support, the software prompts you to launch
EZConfig to read the device's settings.

1. Connect the device to your computer using either the serial port or the diagnostics port and open
Tool Suite

2. Click Configuration in the Applications pane to display the Configuration application.

3. In the Networks section of the Configuration ribbon, select the network to which you want to add a
device.

4. If the device is serial, ensure the correct Com port is selected in theCom Port field. To find the
correct port for the computer on which you are working, look in theWindows Control panel under
System > Hardware > Device Manager >Ports. 

Tool Suite pulls its Com port settings from theWindows operating system when you open Tool
Suite. If you configured the Com port after opening Tool Suite, or connected a device to Tool Suite
after opening Tool Suite, youmight need to close the application and reopen it to select the correct
Com port.

Note: If a Com port is not configured inWindows, it is not available in Tool Suite.

If the device is an Ethernet device, ensure the correct IP address for the device is entered in the
IP Address field.

5. Click Read Radio to import settings from the device that is currently connected, or click Read
Serial Base if you are reading the settings from a Serial Base device.

If you are reading an Ethernet device, you are prompted to enter the device's password if the
password has changed since the last time you read the device from your current instance of Tool
Suite.

If you are reading a Serial Base with ExpansionModules in a stack, Tool Suite reads the Serial
Base plus all ExpansionModules connected in the stack (a stack consists of one I/O Expansion
Serial Base or serial device, for example, FGR2-IO-IOE, and up to 15 ExpansionModules such as
IOEX-4422.
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Note: If you read a serial device's settings using the diagnostics cable, the device is
placed into Setupmode automatically and all three LEDs on the device turn
solid green. If you are reading a serial device's setting using the serial port, Tool
Suite prompts you to place the device into Setupmode.

Programming Devices
As you define the changes for a device in your network in the Configuration application, you can send the
changes to the device when it is connected to the computer running Tool Suite. You can also return the device
to its factory default settings.

Note: It is not currently possible to read a serial radio in the Configuration application
connected locally to the computer running Tool Suite. The TCP terminal server
network is only useful for network diagnostics where you want to gather
diagnostics of a serial network through a TCP/IP connection to a terminal
server.

Programming options are located above the tabs in themain Configuration application window, and display
when Tool Suite is reading a device.

1. Click Configuration in the Applications pane to display the Configuration application.

2. In the Networks section of the Configuration ribbon, select the network that contains the devices
you want to program.

3. Connect to the device and click Read Radio to poll the device for its settings.

4. Make changes to the settings, as necessary.

5. Select one of the following programming options in the Network Title ribbon to send the settings to
the device:

Programming Options Description

All Sends all the settings to the device, even if you
have not made changes to a setting.

If you are programming an Ethernet device, you can
send the settings to another device in the network.
Enter that device's IP address when prompted.

Quick Sends only the settings that you have changed.

Note: TheQuick programming option is only
available for changes made in the current session. If
you close Tool Suite or select a different device, the
Quick option is no longer applicable.

Default Sends the factory default settings for all parameters
to the device. AnswerYes at the prompt to set the
radio back to its factory default settings.

When the device is programmed, the device's Carrier Detect (CD) LED displays solid green and
the Clear to Send (CTS) LED displays solid red.
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About Device Parameter Settings
The network type that you are viewing, serial or Ethernet, determines the device templates that you can add to
the network. Each set of devices has a set of parameters that you can configure and then send to the device.
The parameters are grouped together in tabs that display in the Configuration application's main pane.

Note: The template parameter settings in a serial or TCP network are identical.

Each device can contain a different set of tabs and parameters, however, most devices in a serial network
contain the same parameter settings andmost devices in an Ethernet network contain the same parameter
settings.

Note: The tabs names correspond to themenus as they appear in Setup Terminal and
HyperTerminal.

The following sections provide a brief overview of the contents of each tab in the different network types. For
details about how the parameters apply to the device you are setting and recommended values for each, refer
to the documentation for the device you are configuring.

Note: Parameters that display with a double asterisk (**) are parameters that must be
the same for all devices across your network.

Serial/TCP Terminal Network Device Parameter Tabs
The parameters for most devices available in a serial and TCP terminal devices include the following:

The following table provides an overview of the contents of each tab. For details about how the parameters
apply to the device you are setting and recommended values for each, refer to the documentation for the
device you are configuring.
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Tab Description

Device Information Includes basic device identification information such as the device name,
model number, and serial number. Common diagnostics information is also
available on this tab if you are reading a device.

(0) OperationMode OperationMode defines the device function (Master, Repeater, Slave, etc).
FreeWave transceivers operate in aMaster to Slave configuration. For
transceivers to operate together, proper communication setup is required. 
Serial Ethernet options are also configured in this tab. 

(1) Baud Rate Includes communication settings between the transceiver and the
instrument to which it is connected.

(2) Call Book Includes the call information to incorporate up to 10 FreeWave transceivers,
designate 1 to 4 Repeaters for use with each transceiver, and designate
which specific Slave theMaster calls, by serial number. 

Note: The Call Book is required in Point-to-Point networks.

(3) Radio Transmission 
Characteristics

Includes parameters that change how a transceiver sends data, for example
frequency keys and low power settings. Many of the parameters in this tab
must bemaintained across the network for proper functionality.

Note: The options in this tab determine the RF characteristics of the
network.  Default settings are not recommended for the network critical
settings.  However, an understanding of the settings in this menu is
recommended prior to changing any of the values.

(5) MultiPoint Parameters Includes settings used to control how data is handled in situations requiring
retries and the settings to control the behavior of aMulitPoint Slave or
Repeater.   

When installingMultiPoint networks it is important to do some initial
planning. Unlike Point-to-Point networks, a Point-to-MultiPoint network
requires several parameters to be set consistently on all transceivers in the
network. This includes RF Data Rate, Min and Max Packet Size, and
Frequency Key.

(6) TDMA Settings Includes TimeDivisible Multiple Access (TDMA) settings, which allow
transceivers to complete various operations in specific time slots. This
option is only used for peer-to-peer communications or when applications are
very time specific.

For additional information about TDMA, contact FreeWave Technical
Support.

Ethernet Device Parameter Tabs
The parameters for Ethernet network devices include the following :
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The following table provides an overview of the contents of each tab. For details about how the parameters
apply to the device you are setting and recommended values for each, refer to the documentation for the
device you are configuring.

Tab Description

Device Information Includes basic device identification information such as the device name,
model number, and serial number. Common diagnostics information is also
available on this tab if you are reading a device.

IP Setup Contains communication information such as IP address and Default
Gateway address for the device.

Check with your Network Administrator before altering any settings in this tab.

Serial Setup 1 Contains data settings for serial port 1 on the device. These settings need to
match the serial device connected to this port. Serial ports 1 and 2 are
independent of each other; they can have different baud rates, parity, protocol,
and so on.

Call Book Includes the call information to incorporate up to 10 FreeWave transceivers,
designate 1 to 4 Repeaters for use with each transceiver, and designate which
specific Endpoint the Gateway calls, by serial number. 

Note: The Call Book is required in Point-to-Point networks.

Serial Setup 2 Contains the data settings for serial port 2 on the device. These settings need
tomatch the serial device connected to this port. Serial ports 1 and 2 are
independent of each other; they can have different baud rates, parity, protocol,
and so on.

Radio Setup Contains all the settings regarding general radio setup such as Operation
Mode and transmission characteristics.

Security Contains security settings such as RADIUS authentication, passwords, and
encryption keys.

Note: MAC filtering is not currently supported in Tool Suite.

SNMP Contains all SNMP management features, such as the SNMP version.

All of the SNMP manageable objects for the FreeWave Ethernet devices are
contained in a single MIB file. FREEWAVE-TECHNOLOGIES-MIB. This file
is available from FreeWave upon request.

RMS Contains settings for enabling a Redundancy Master Station (RMS) and set-
tings for themain and back up devices.

Users Contains the group permissions to view and change settings.

Tools Contains free-form fields where you can define a site information such as a
site contact.

I/O Serial Base and Expansion Module Device Parameter Tabs
The parameters for I/O Serial Bases and ExpansionModules include the following:
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For details about how the parameters apply to the device you are setting and recommended values for each,
refer to the documentation for the device you are configuring. The following table provides an overview of the
contents of each tab.

Tab Description

Device Information Includes basic device identification information such as the
device name, model number, and serial number.

(0) Universal Channels Corresponds and programs channels 1, 2, 3, and 4 of the I/O
Serial Base and ExpansionModule devices.

(1) Input Channels Corresponds and programs channels 5, 6, 7, and 8 of the I/O
Serial Base and ExpansionModule devices.

(2) Isolated Digital Inputs Corresponds and programs channels 9 and 10 of the I/O Serial
Base and ExpansionModule devices.

(3) Isolated Digital Output Corresponds and programs channels 11 and 12 of the I/O Serial
Base and ExpansionModule devices.

(4) Stack Settings Applies to the I/O Serial Base and programs how the stack
communicates with external Modbus devices.

About Network Designs
Use the Network Design feature to design and configure a virtual network prior to programming devices. The
Network Design gives you a visual representation of which devices are connected in your network. You can
use the Network Design feature without previously adding devices to a network using the Devices tree.

Create network designs for a serial or an Ethernet network.

Creating a Serial Network Design Using the Design Wizard
Using the Network Design wizard to define an Ethernet network creates amaster template device from which
the other devices in the network design are based. When you first enter theNetwork Design tab in a network,
Tool Suite prompts you to add aMaster using the Create Network DesignWizard.

Note:When creating Network Designs, the devices are applied to the current network
that is selected. If you have not created or selected a unique network, the
Network Design applies to the Default Network.

1. Click Configuration in the Applications pane to display the Configuration application.

2. From the Networks area in the Configuration ribbon, select the serial network you want to design.

3. Click theNetwork Design tab.

If the Create Network Design wizard does not display, right-click anywhere in the Network Design
pane and select Template Wizard.

4. From theRadio Type drop-down list, select theMaster radio type and click Next.

5. From the Network Structure drop-down list, select the network type and click Next.
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Note: As of Tool Suite version 2.8.0, Point-to-Point and TDMA network structures are
not yet supported in the Create Network Design wizard.

6. When prompted, set the following critical settings or accept the default settings and click Next.

For FreeWave radios to successfully communicate with one another within a network there are
five critical settings that must be the same across all radios in the network.  Slaves, Repeaters, or
Slave/Repeaters connected to theMaster template inherit these settings from theMaster. 

Setting Description

Frequency Key Select a value from 0 to 9 or letters A to E.

Max Packet Size Select from numbers 0 through 9.

Min Packet Size Select from numbers 0 through 9.

RF Data Rate Select the RF data rate. Depending on the device, this could
also be a selection or 1, 2, or 3.

Network ID Select from 1 through 4095. 255 enables the Call Book.

7. Configure data port settings, which any connected Slave, Repeater, or Slave/Repeater inherits as
well and click Next.

Note: Formore information regarding settings, see the user manual for the radio.

8. In the Template Name field, enter a name that identifies theMaster device and click Finish to
save the template.

After the initial creation of theMaster radio template is complete, aMaster radio icon displays
under the Network Design tab with the previously selected network parameters. To connect
devices to theMaster, see "Connecting Devices toMaster Templates in Network Designs" on
page 35.

Creating an Ethernet Network Design Using the Design Wizard
Using the Create Network Design wizard to define an Ethernet network creates amaster device from which
the other devices in the network design are based. When you first enter theNetwork Design tab in a network,
Tool Suite prompts you to add aMaster using the Create Network DesignWizard.

Note: Youmust create a Plus Ethernet network before you can access the Network
Design feature to create an Ethernet network.
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1. Click Configuration in the Applications pane to display the Configuration application.

2. From the Networks area in the Configuration ribbon, select the Ethernet network you want to
design.

3. Click theNetwork Design tab.

If the wizard does not display, right-click anywhere in the Network Design pane and select
Template Wizard.

4. From theRadio Type drop-down list, select the Gateway radio type and click Next.

5. From the Network Structure drop-down list, select the network type and click Next.

Note: As of Tool Suite version 2.4.0, Point-to-Point and TDMA network structures are
not yet supported in the Network Design feature.

6. When prompted, set the following critical settings or accept the default settings and click Next.

For FreeWave Ethernet radios to successfully communicate with one another within a network
there are eight critical settings that must be the same across all radios in the network. Any
Endpoint or Repeater connected to the Gateway template inherits these settings. 

Setting Description

Subnet Mask Typically assigned by your network administrator.

Default Gateway Typically assigned by your network administrator.

Frequency Key Select from numbers 0 to 9 and letters A to E.

Max Packet Size Select from numbers 0 through 9.

Min Packet Size Select from numbers 0 through 9.

RF Data Rate Select 115 kbps for a low RF data rate or 154 kbps for a high
data rate. Different rates are available if you selected a high
throughput device as your master.

Master Tx Beacon Select from numbers 0 through 9.

Network ID Select from 1 through 4095. 255 enables the Call Book.

Note: Formore information regarding settings, see the user manual for the radio.

7. In the Template Name field, give the Gateway device template a name and then click Finish to
save the template.

After the initial creation of the Gateway radio template is complete, aMaster icon appears under
the Network Design tab with the previously selected network parameters. To connect devices to
themaster, see "Connecting Devices toMaster Templates in Network Designs" on page 35.
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Connecting Devices to Master Templates in Network Designs
After creating a template for aMaster radio in your network, the next step is to connect Slaves, Repeaters,
and Slave/Repeaters for programming to theMaster in the network design. Devices connected to theMaster
inherit themaster's settings.

To connect a serial device:

1. Click Configuration in the Applications pane to display the Configuration application.

2. From the Networks area in the Configuration ribbon, select the serial network you want to design
and click theNetwork Design tab.

3. Right-click theMaster icon, select Connect, and select themodemmode of the device to attach. 

4. In theName field, enter a name that identifies the device.

5. From theRadio Type drop-down list, select the device type. All possible types that can connect to
theMaster are listed.

6. Click Add. 

An icon for the device displays with the inherent critical settings. For example:
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7. To connect another radio to a Repeater or Slave/Repeater, right-click the device icon to which you
want to add a connection and repeat the steps above to add a device.

Note: If multiple Repeaters or Slave/Repeaters are connected, Tool Suite
automatically enables Repeater Frequency and assigns a unique frequency
key for each subsequent Repeater or Slave/Repeater connected.

To connect an Ethernet device:

1. Click Configuration in the Applications pane to display the Configuration application.

2. From the Networks area in the Configuration ribbon, select the Ethernet network you want to
design and click theNetwork Design tab.

3. Right-click theMaster icon, select Connect, and select themodemmode of the device to attach. 

4. In theName field, enter a name that identifies the device.

5. From theRadio Type drop-down list, select the device type. All possible types that can connect to
theMaster are listed.
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Many advanced features of the Ethernet devices do not function correctly in networks where
Repeaters are enabled.  For best operation, FreeWave Technologies, Inc. does not recommend
the use of single-radio Repeaters for Ethernet devices.

6. Click Add.

An icon for the device displays with the inherent critical settings. For example:

Note: One Slave node can be programmed for many radios.  There is no need to
connect multiple slaves together, when programming, simply change the Radio
Namewhen prompted for the subsequent slave(s) as you program them.

7. To connect another radio to a Repeater, right-click on the radio to add a connection to and repeat
the steps to add a Slave connection.

Editing Settings for Devices in Network Designs
After you add a device to a network design, you can edit each device's settings that were not addressed
during the wizard setup. For example, you can change a device's Ethernet settings or baud rate.

1. Click Configuration in the Applications pane to display the Configuration application.

2. From the Networks area in the Configuration ribbon, select the network you want to edit and click
theNetwork Design tab.

3. Right-click the device you want to change to display the parameter tabs.  The same tabs display
with the same settings as on the Configurationmain window when you select a device.

4. Make the necessary changes and click Update to save the settings orCancel to exit without
saving any changes.

Tool Suite prompts you to select whether the settings changes affect just the selected radio or all
the radios in the virtual network. 

5. Click Yes to apply the changes to all connected devices in the template, No to apply the changes
to only the selected device, orCancel to return to the Edit Settings window without applying the
changes.

Tool Suite refreshes the devices with the changes.

Removing Devices From Network Designs
You can delete a group of devices or a single device that does not have another device connected to it from a
Network Design. For example, if you remove theMaster or a Repeater from the Network Design, all
connected devices are deleted as well. If you removing only a Slave (or Endpoint) that is at the end of a
network, only that device is deleted.

37



Chapter 3: Configuration Application

LUM0030AB Rev C

1. Click Configuration in the Applications pane to display the Configuration application.

2. From the Networks area in the Configuration ribbon, select the network you want to remove and
click theNetwork Design tab.

3. Right-click the device you want to delete and select Remove.

4. Select Yes at the prompt to proceed orNo to cancel without deleting the device.

Renaming Devices in Network Designs
After a device is added to a Network Design, you can rename the device, as necessary.

1. Click Configuration in the Applications pane to display the Configuration application.

2. From the Networks area in the Configuration ribbon, select the network you want to edit and click
theNetwork Design tab.

3. Right-click the device and select Rename.

4. In theName field, enter the new name and click Update to save the change orCancel to exit
without making any changes.

Tool Suite prompts you to verify the change. 

5. Click Yes to proceed with the change orNo to exit and close out without making a change.

Printing Network Designs
You can print a network design for review or to keep on file.

1. Click Configuration in the Applications pane to display the Configuration application.

2. From the Networks area in the Configuration ribbon, select the network you want to print and click
theNetwork Design tab.

3. Right-click in an empty area of the Network Design and select Print. 

A print preview window with print options displays. 

4. Select the printer to print to andmake any printing adjustments, as needed and click Print.

Exporting and Importing Network Designs
You can export a Network Design for use in another instance of Tool Suite. Network Design files have a .fwt
extension.

To export a Network Design:

1. Click Configuration in the Applications pane to display the Configuration application.

2. From the Networks area in the Configuration ribbon, select the network you want to export and
click theNetwork Design tab.

3. From theOptions drop-downmenu in the Network Title ribbon, select Export > FreeWave
Network Design.

You can also right-click in the Network Design window and select Export Design.

4. Select the location to where you want to save the file, enter a file name, and click Save.

You can now attach the file in an email, add it to an external drive, or place it on a CD.
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To import a Network Design:

1. Click Configuration in the Applications pane to display the Configuration application.

2. From the Networks area in the Configuration ribbon, select the network you want to design and
click theNetwork Design tab.

3. If a Network Design exists, right-click in the Network Design window and click Clear Templates. 
After the Network Design area is clear, right-click and select Import Design.

4. After the file imports, right-click the desired device for programming and select Program Settings
while connected to the device to receive those settings.

Programming Devices From Network Designs
After the Network Design is complete, you can program the settings on the each device individually. Ensure
that the device you want to program is connected to the computer running Tool Suite with the appropriate
cable.

1. Click Configuration in the Applications pane to display the Configuration application.

2. From the Networks area in the Configuration ribbon, select the network you want to program and
click theNetwork Design tab.

3. Right-click the device in the Network Design to program and select Program Settings.

4. In theRadio Name field (or theSite Name field for an Ethernet device) enter the name you want
to program to the device and click Program to send the settings and the name to the device.

Note: Entering a name is optional. You can program the device without entering a
name. If you are programming an Ethernet device, you can also send a new
IP address by entering the IP address in theNew IP Address field. Enter the
current IP address in the New IP Address field if the address should remain the
same.

A status bar displays while the device is being programmed. 

When the device is programmed, the device's Carrier Detect (CD) LED displays solid green and
the Clear to Send (CTS) LED displays solid red.

After the programming is complete, the Network Design window displays. For each subsequent
device in the network that you want to program, connect the serial or diagnostic cable to the radio
for programming and repeat steps 3 and 4.

Note: One Slave node can be programmed for many radios. There is no need to
connect multiple slaves together, when programming. Change the Radio Name
when prompted for the subsequent Slaves as you program them.
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Upgrading to the Latest Firmware Version
Use Tool Suite to upgrade the firmware on your devices from one location. If Tool Suite is connected to a
device, and a new versions of firmware is available for that device, an indication displays on the Device
Information tab in the Configuration application. You can also view the firmware releases available for the
devices in your network.

Note: Currently Tool Suite does not support over-the-air firmware upgrades or
firmware upgrades to Ethernet devices.

To check the current firmware loaded on devices in a network:

1. Click Configuration in the Applications pane to display the Configuration application.

2. From the Networks area in the Configuration ribbon, select the network you want to upgrade.
Ensure a serial network is displayed.

3. Click View Available, in the Firmware section of the Configuration ribbon to display a list of the
latest firmware versions for Tool Suite supported products.

4. Click View next to the firmware version to view the settings for themodel in that version of
firmware.

To upgrade to the latest firmware version:

1. Click Configuration in the Applications pane to display the Configuration application.

2. From the Networks area in the Configuration ribbon, select the network you want to upgrade.
Ensure a serial network is displayed.
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3. Connect to the device you want to upgrade.

4. Click Upgrade in the Firmware section of the Configuration ribbon.

5. Click Yes at the prompt to proceed orNo to cancel without installing the new firmware.

Tool Suite identifies and displays the firmware version that is loaded on the connected device and
displays the latest version of firmware available for that model.

6. Click Yes to proceed with the upgrade, orNo to exit.

The system displays the progress of the firmware upgrade:

After complete, amessage displays that the firmware upgrade was successful.
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Chapter 4: Network Diagnostics Application

Network Diagnostics provides a place to view diagnostic data for all the devices connected to theMaster in
your network in real time. This application is not meant to replicate the functionality of an NMS system, but
rather it is a tool that can be used for diagnostics and troubleshooting in the field.

Important: The Network Diagnostics application is intended for occasional network
monitoring or troubleshooting, not for continuous, long-term collection of diagnostic
data. Aggressive polling by the Network Diagnostics application or polling during
periods of heavy data traffic may cause degradation in data throughput.

Tool Suite is not optimized for the collection andmanagement of large amounts of
diagnostic data from continuous polling. Collection of excessive amounts of data
results in overall performance degradation in Tool Suite.

Finally, you can poll multiple networks simultaneously, however this is not
recommended. Depending on the number and size of networks being polled, Tool Suite
may experience performance degradation or instability.

Review the "Network Diagnostics Best Practices" on page 44 before using the
application.

This chapter discusses the following about the Network Diagnostics application:

l Path View and what displays in it.

l Polling and searching for devices in your network.

l Setting the parameters that you want to monitor and determining what flags a device as having an
alert or warning.

l Running and viewing network diagnostic data.

Click Network Diagnostics in the Applications pane to get started.
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Network Diagnostics Best Practices
Because there are several variables involved, FreeWave cannot provide a one-size-fits-all recommendation
for all settings when running Network Diagnostics. Each situation is different, and you will need to determine
the settings and usage pattern that work best for you. FreeWave does recommend following the best
practices below for optimum network stability and performance, as well as Tool Suite stability and
performance:

l UseNetwork Diagnostics only for occasional monitoring or troubleshooting, not continuously.

l Poll only one network at a time.

l Poll networks at times of low data throughput. (Turn the polling host off or poll between scheduled
SCADA polls.)

l Increase polling intervals to reduce the number of diagnostic polls injected into the network and
reduce the amount of diagnostic data collected. For example, change from the default of 200ms to
2000ms unless discovering a new network.

l Set networks to clear diagnostics after the shortest acceptable time interval.

Discovering and Reading Devices
To run diagnostics using the Network Diagnostics application youmust poll the network for the devices that
are available and the devices current settings.

Note: Prior to running diagnostics for your network, youmust define the network you
want to diagnose. For more information, see "Creating Configuration and
Network Diagnostics Networks" on page 13.
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Discovering Ethernet Devices
To search for Ethernet devices available to add to your diagnostic network, you can run a discovery for all
devices available.

1. Click Network Diagnostics in the Applications pane to display the Network Diagnostics
application.

2. From the drop-downmenu in the Networks section of the ribbon, select an Ethernet network.

3. From theOptions drop-downmenu in the network title ribbon, select Discover Radios to display
the Plus Radio Discovery window.

4. Click Search and select a length of time to automatically stop searching for devices.

To stop searching before the allotted time, click Search again.

Devices discovered in the network display in the device list.

5. To add the devices listed to the diagnostic network, click Add Radios.

To clear the discovery list, click Clear.

The devices you add display in the Path View for the network. For more information, see "Network
Diagnostics Path View" on page 46.

Reading Ethernet Device Settings
When running diagnostics on an Ethernet network, you can poll all devices in the network for settings, name,
and firmware versions.
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Note: Polling for a device's Name and firmware version is only available on Ethernet
devices running firmware versions 2.18 and above.

To read an Ethernet device for settings:

1. Click Network Diagnostics in the Applications pane to display the Network Diagnostics
application.

2. In the Networks section of the Network Diagnostics ribbon, select an Ethernet network.

3. From theOptions drop-downmenu in the Network Title ribbon, select Read > All Radios.

4. Tool Suite reads the settings from all Ethernet devices available in the network.

To read an Ethernet device for its name and Firmware version:

1. Click Network Diagnostics in the Applications pane to display the Network Diagnostics
application.

2. In the Networks section of the Network Diagnostics ribbon, select an Ethernet network.

3. From theOptions drop-downmenu in the Network Title ribbon, select Read > Name/Firmware
Version.

4. Tool Suite reads the name and current firmware version installed on all Ethernet devices available
in the network.

Network Diagnostics Path View
The Path View tab displays a tree view of devices, and their Master/Repeater/Slave hierarchy in the network.
The devices display in the tree whether they were addedmanually or through a discovery feature. 

The icons next to the devices help to identify where they fall in the network hierarchy. In addition, the color of
each icon indicates whether the device is in an warning or alarm status. For more information, see "About
Alerts " on page 47.

The devices in the Path View display with one of the following icons:

l M Icon - Indicates aMaster in the network.

l S Icon - Indicates a Slave in the network.

l R Icon - Indicates a Repeater in the network.

l S/R Icon:  Indicates a Slave/Repeater in the network.
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Each device in the Path View has a check box. When a device's check box is selected, the device gets
actively polled when the network is set to poll. Devices whose check box is not selected are excluded from
polling. All related devices linked to aMaster are selected or unselected when theMaster in the hierarchy is
selected or unselected. UseCtrl + left-click to change the selection for a single device in the tree.

Searching for Devices in the Network
If you have a large network, use the Search option to locate the device in the Path View in the Network
Diagnostics application.

1. Click Network Diagnostics in the Applications pane to display the Network Diagnostics
application.

2. In the Networks section of the Network Diagnostics ribbon, select the network you want to search.

3. Click theSearch option in the Network Title ribbon.

4. Enter a device name or a serial number. If you are searching in an Ethernet network, you can also
search by IP address of the device using theEnter an IP Address field.

Note: Enter serial numbers without a dash.

As you type in the search fields, Tool Suite searches for devices that match your search criteria
and displays thematches in a list. Select amatching device at any time to jump to it in the Path
View. Continue to typemore text to refine the search results.

If Tool Suite finds a single device that matches the search criteria you enter, it jumps to the device
and highlights it in the Path View.

About Alerts
When you run network diagnostics, Tool Suite polls the devices for the parameters described in "Parameter
Definitions and Recommended Values" on page 53. Use alert definitions to enter the parameters and settings
that you want to be visually notified about if the condition occurs in your network.

For example, if you want Tool Suite to alert you when a device's voltage goes above the recommended limit,
you can set up an alert as either a warning or alarm.

As you run diagnostics and poll the devices in your network, if a device has a parameter that sends it into an
alert or warning status, the device's icon in the Path View reflects the state of the device, providing you an
instant visual queue that a condition exists.

l - The device is in an alarm state.

l - The device is in a warning state.

Note: If the device displays with a blue icon, it has no alarms or warnings or all alarms
or warning have beenmarked as acknowledged. For more information, see
"Acknowledging and Clearing Alerts" on page 49.
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You can drill into each device that has an alert state to review the details about the alert, the data received
during the poll of the device, and the time that poll took place. Use this information to help troubleshoot the
device's error.

To work with alerts, first set the parameters you want to monitor.

Setting Alert Definitions
Alerts are categorized as either warnings or alarms. The set of diagnostic parameters you can set as warnings
or alarms is the same. Where you activate the alert determines whether Tool Suite displays the condition as a
warning or an alarm in the Network Diagnostics application.

Note: The network must be stopped before you canmodify the alert definitions.

1. Click Network Diagnostics in the Applications pane to display the Network Diagnostics
application.

2. In the Networks section of the Network Diagnostics ribbon, select the network for which you want
to define alert definitions.

3. If necessary, click Stop to stop polling the network.

4. From theOptions drop-downmenu in the network title ribbon, select Alert > Modify Alert
Definitions to display the Alert Definitions window.

5. To define parameters that flag a device with aWarning , click theWarnings tab and set your

definitions there. To define parameters that flag a device with an Alarm click theAlarms tab.
6. To activate a warning or alarm for a device condition, select the check box in the Active column for

the diagnostic.

7. In theWarn Below andWarn Above fields for the diagnostics that you activated, set the range in
which something is considered in fault.

For example, if you set theWarn Below field for the In Margin diagnostic to 20.00 in theWarnings tab, if the
device's margin falls below 20.00 dB, the system flags the device with a warning in the Network Diagnostics
application and changes the device icon to yellow in the Path View.
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If you set theWarn Below field for the In Margin diagnostic parameter to 20.00 dB in the Alarms tab, if the
device's margin falls below 20.00 dB, the system flags the device with an Alarm in the Network Diagnostics
application and changes the device icon to red in the Path View.

Acknowledging and Clearing Alerts
As you are reviewing devices that are in an alert state, you can acknowledge an alert so the device no longer
displays in an alert state. For example, youmight acknowledge a warning if you understand why the device
has that warning and are working on the solution. Acknowledged alerts still display in the list of alerts for a
device in the Alerts tab, however, they do not cause the device's icon to change color in the Path View.

After you have resolved the condition causing an alert, you can clear the alert. Clearing the alert removes the
alert from the alert list in the Alert tab.

To acknowledge individual alerts on a device:

1. Click Network Diagnostics in the Applications pane to display the Network Diagnostics
application.

2. In the Networks section of the Network Diagnostics ribbon, select the network in which you want
to acknowledge alerts.

3. Select the device that is an alert state and click theAlerts tab at the bottom of themain window to
display the list of alerts for device.

4. Select the check box in theAck'd field next to the alerts you want to acknowledge.

5. Click Acknowledge Alerts.

The alert indicator for the device in the Path View is removed. The alerts remain in the Alerts list for
your reference.
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To acknowledge all alerts on a device:

1. Click Network Diagnostics in the Applications pane to display the Network Diagnostics
application.

2. In the Networks section of the Network Diagnostics ribbon, select the network in which you want
to acknowledge alerts.

3. Select the device that is an alert state and click theAlerts tab at the bottom of themain window to
display the list of alerts for device.

4. From theOptions drop-downmenu in the network title ribbon, select Alerts > Acknowledge All
Alerts.

The alert indicator for the device in the Path View is removed. The alerts remain in the Alerts list for
your reference.

To clear an alert:

1. Click Network Diagnostics in the Applications pane to display the Network Diagnostics
application.

2. In the Networks section of the Network Diagnostics ribbon, select the network in which you want
to clear alerts.

3. Select the device for which you want to clear alerts and click theAlerts tab at the bottom of the
main window to display the list of alerts for device.

4. Click Clear Alerts.

The alert indicator for the device in the Path View is removed and all the alerts are cleared from the
Alerts list.

Showing Only Devices With Alerts
Use the filtering option to view only devices in the Path View in that are in an alert status.

1. Click Network Diagnostics in the Applications pane to display the Network Diagnostics
application.

2. In the Networks section of the Network Diagnostics ribbon, select the network in which you want
to view devices with alerts.

3. From the Filter drop-downmenu in the network title ribbon select from one of the following options:

l Show Alerts - Shows all devices with an alarm or warning in the Path View.

l Show Warnings - Shows only devices with a warning condition in the Path View.

l Show Alarms - Shows only devices with an alarm condition in the Path View.

To return to an unfiltered view, select Show All from the Filtermenu.

Polling Devices With Alerts
If you are troubleshooting a device in an alert state, you can poll only the devices in your network that currently
have alarms or warnings.

To poll only devices with alerts:

1. Click Network Diagnostics in the Applications pane to display the Network Diagnostics
application.
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2. In the Networks section of the Network Diagnostics ribbon, select the network in which you want
to poll devices with alerts.

3. From thePollingdrop-downmenu in the network title ribbon select from one of the following
options:

l Poll Radios With Alerts - Polls only the devices with an alarm or warning condition.

l Poll Radios With Warnings - Polls only devices with a warning condition.

l Poll radios With Alarms - Polls only devices with an alarm condition.

Creating Alert Reports
Generate a report by date range of devices in a network that are in alert state. Using a report lists the devices
by serial number and provides a way to print, save as a PDF file, or to view the devices with alerts in Microsoft
Excel. Reports can be helpful if troubleshootingmultiple devices or comparing a troubled device with others
that are not in an alert state.

1. Click Network Diagnostics in the Applications pane to display the Network Diagnostics
application.

2. In the Networks section of the Network Diagnostics ribbon, select the network in which you want
to create an alert report.

3. From theOptions drop-downmenu in the Network Title ribbon, select Alerts > View Report.

4. In the Alert Reporting window, enter the date range for which you want to include alarm data in the
report. For example, if you want to see alarm data for the last month, enter the first and last days of
that month in the corresponding fields.

5. From theAlert Level drop-down list, select from one of the following options:

l All - Includes all alerts that occurred for the device in the date range you specify.

l Warnings - Includes only warnings that occurred for the device in the date range you specify.

l Alarms - Includes only alarms that occurred for the device in the date range you specify.

6. Click Report to generate the report.

The Report displays in a separate window and sorts by serial number.
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Running and Viewing Network Diagnostics
Important: Review the "Network Diagnostics Best Practices" on page 44 before
running the Network Diagnostics application.

After a network is defined, select the network from the Networks section of the Network Diagnostics ribbon
and click Start to begin gathering diagnostic data.

As Tool Suite receives information from the devices in the network, it populates the Path View and the graph
for the selected device begins to display information showing how the device is functioning. Tool Suite offers
multiple ways to review network diagnostic data.

Note: If you are running diagnostics on an Ethernet network, note that broadcasts may
be blocked through certain brands of routers. If data is not displaying in Tool
Suite and other factors have been ruled out, try connecting the Ethernet cable
directly to the computer's Ethernet port.

l Graph view - Displays all the current data in a chart. See "Using the Network Diagnostics Graph
View" on page 55.

l Summary view - Provides themost recent diagnostics in summary table format. See "Using the
Network Diagnostics Summary View" on page 58.

l Trend Analysis view - Displays a trend analysis of the parameters polled in past network
diagnostic runs. See "Using the Network Diagnostics Trend Analysis View" on page 59.

l History view - Displays an at-a-glance history of the parameters polled in past network diagnostic
runs. This view is only available in serial and TCP networks. See "Using the Network Diagnostics
History View" on page 58.
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The Poller Status located at the very bottom of the window indicates if the poller is connected or
disconnected. If the poller is connected, but no radios are added to the Path View, double check that the
diagnostic cable is connected to theMaster radio.

Parameter Definitions and Recommended Values
As you use the Network Diagnostics application, the following parameters are available in each of the views.
refer the following parameter definitions and the recommended values for each. For more information about
each of these parameters in a particular device, see that device's user manual or addendum.

Parameter Description

Inbound Signal The signal the Slave or Repeater receives from theMaster or Repeater
to which that device is linked.

Inbound Noise The noise at the selected Slave or Repeater.

Outbound Signal The signal theMaster or Repeater receives from the Slave.

Outbound Noise The noise in the outbound transmission at theMaster or Repeater

In/Out Margin The difference between the signal and noise. In Margin is the spread of
points between the Inbound Noise and Inbound Signal. FreeWave
recommends aminimum of 20 dB. This recommendationmeans the
signal needs to be 20 dB higher than the noise level.

Out Margin is the spread of points between theOutbound Noise and
Outbound Signal.

A spread of 20 dB or greater is considered ideal.
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Parameter Description

Voltage The input voltage the device receives. This value should be within the
specified range of the device that is being read. For example, FGR
series radios should be between the 6 and 30 Volts DC.

Temperature The physical temperature of the device.

VSWR The amount of signal being reflected back into the device. A reading
between 0 and 5 is considered good; between 6 and 25 is Fair; between
26 and 30 or higher is considered Poor and needs attention.

Receive % The percentage of data packets that were successfully transmitted from
theMaster to the Slave on the first attempt. A number of 75 or higher
indicates a robust link that provides very good performance even at high
data transmission rates. A number of 15 or lower indicates a weak or
marginal link that provides lower data throughput. AnOverall Receive
Rate of 100% provides approximately 100 KBaud of bandwidth with an
RF Data Rate setting of 3 and approximately 150 KBaud of bandwidth
with anRF Data Rate of 2. These numbers are reduced approximately
50% if one or more Repeaters are in the network.

Diag Poll % (serial
only)

The percentage of the time that the radio reported back diagnostics data
when polled. If the device transmits a lot of data as part of its normal
operation, it has less time to respond to theMaster polling it for diag-
nostics data; in that case, the diagnostics response rate decreases. If
this value is 0, it may be because this device is disconnected from the
network.

Transmit % (Ethernet
only)

The percentage of packets the device sends sent that successfully
reach the upstream device (Gateway or a Repeater). This statistic
shows 0.00% on aMultipoint Gateway or Multipoint Repeater. This sta-
tistic is only valid onMultipoint Endpoint devices. FreeWave rec-
ommends aminimum of 75% for proper device operation.

Polling Devices for Diagnostics
If devices are not automatically discovered, or the settings have not populated in the Network Diagnostics
application, you canmanually poll a single device to discover it and/or the device’s settings. While polling an
active Ethernet network, you can poll a range of IP addresses the network spans to discover devices. 

To poll a device, Tool Suite must be actively polling the network. The polling indicator light displays a green
light when Tool Suite is polling a network and a red light if the network is disconnected.

To poll serial devices for diagnostics:

1. Click Network Diagnostics in the Applications pane to display the Network Diagnostics
application.

2. In the Networks section of the Network Diagnostics ribbon, select the network in which you want
to poll devices.

3. From theOptions drop-downmenu in the Network Title ribbon, select Poll Radio.
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4. In the Serial Number field, enter the serial number of the device you want to poll.

5. Click Poll to poll the device or click Cancel to exit without polling the device.

To poll for Ethernet devices for diagnostics:

1. Click Network Diagnostics in the Applications pane to display the Network Diagnostics
application.

2. In the Networks section of the Network Diagnostics ribbon, select the network in which you want
to poll devices.

3. From theOptions drop-downmenu in the Network Title ribbon, select Poll Radio.

4. In the Start Address and End Address fields, enter the first and last IP addresses in a range of
addresses for which you want to poll devices.

5. Click Poll to poll the range of addresses or click Cancel to exit without polling the device.

The polled Ethernet devices display in the Path View window pane once discovered.

Using the Network Diagnostics Graph View
You can view the data from a network diagnostic in graph form. Tool Suite charts all the current data for the
device on a single graph. You can zoom in and out on different parts of the graph for greater magnification. The
graph contains the following data across the top of the graph.

l Last Response - Displays the date and time for the last time the radio responded to a poll.

l Missed Polls - Tracks the number of times Tool Suite polled the device without a response. After
there is a successful poll, theMissed Polls number resets to zero.

l Data Sent - Only available for Ethernet networks, Data Sent tracks the increasing number of polls
a radio has sent out. When running diagnostics for Serial devices, theData Sent number remains
at zero.
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To display the graph view:

1. Click Network Diagnostics in the Applications pane to display the Network Diagnostics
application.

2. In the Networks section of the Network Diagnostics ribbon that contains the device you want to
view.

3. In the Radio tree view, select the device you want to review.

4. Click theDiagnostic tab at the bottom of the Network Diagnostics window.

To change the data displayed in the graph:

1. Click Network Diagnostics in the Applications pane to display the Network Diagnostics
application.

2. In the Networks section of the Network Diagnostics ribbon that contains the device you want to
view.

3. In the Radio tree view, select the device you want to review.

4. Right-click anywhere in the graph and select the parameters you want to view or deselect the
parameters you no longer want to view:
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To change the time period displayed in the graph, select Chart Span and the time period to
display.

To zoom in and out in the graph:

1. With the graph displayed, hold down the left button on themouse at the uppermost or lowest point
of the area on the graph in which you want to zoom.

2. Drag themouse across the entire area on which you want to zoom.

To zoom out, click theO in either the top upper left corner (controls zooming out at the Y-axis)
and/or the lower left corner (controls zooming out at the X-axis) of the graph.
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Note: The number of times the graph was magnified equals the number of times you
need to click either one of the reset points to return the graph to the normal view.

Using the Network Diagnostics Summary View
The Summary view displays themost recent polls and provides an overview of all the diagnostics on a single
page. From the Summary view, you can copy and paste data into aMicrosoft Excel spreadsheet.

Serial and TCP/IP Summary View:

Plus Ethernet Summary View:

To display the Summary view:

1. Click Network Diagnostics in the Applications pane to display the Network Diagnostics
application.

2. In the Networks section of the Network Diagnostics ribbon that contains the device you want to
view.

3. In the Radio tree, select the device you want to review and click the Summary tab.

To copy data to a Microsoft Excel spreadsheet:

1. Click Network Diagnostics in the Applications pane to display the Network Diagnostics
application.

2. In the Networks section of the Network Diagnostics ribbon that contains the device you want to
view.

3. In the Radio tree, right-click the device and chooseSelect All, and copy and paste the information
into anMicrosoft Excel Spreadsheet.

Using the Network Diagnostics History View
The History view displays a log of Slaves/Endpoints that recently transmitted data. This view is most useful if
your network contains a "Chatty Slave." Use this view to review a pattern of repeated data transmissions.

Note: This feature is only available in serial and TCP/IP networks.

The last received radio is displayed next to the View History button.
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1. Click Network Diagnostics in the Applications pane to display the Network Diagnostics
application.

2. In the Networks section of the Network Diagnostics ribbon that contains the device you want to
view.

3. in the Radio tree view, select the device you want to review.

4. Click View History at the bottom of the Network Diagnostics window.

5. In the Results Displayed field, select how many results to display, 10 to 100. .

6. Tomanually refresh the history list, click Refresh.

If theAuto Refresh check box is selected, the list automatically updates.

Using the Network Diagnostics Trend Analysis View
The Trend Analysis view shows an analysis of reported data for the time you specify to view.
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To display the Trend Analysis view:

1. Click Network Diagnostics in the Applications pane to display the Network Diagnostics
application.

2. In the Networks section of the Network Diagnostics ribbon that contains the device you want to
view.

3. In the Radio tree view, select the device you want to review.

4. Click theHistory tab at the bottom of the Network Diagnostics window.

5. In the Time Span field, select the time period for which you want to display data.

To zoom in and out in the Trend Analysis:

1. With the graph displayed, hold down the left button on themouse at the uppermost or lowest point
of the area on the graph in which you want to zoom.

2. Drag themouse across the entire area on which you want to zoom.
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To zoom out, click theO in either the top upper left corner (controls zooming out at the Y-axis)
and/or the lower left corner (controls zooming out at the X-axis) of the graph.

Note: The number of times the graph was magnified equals the number of times you
need to click either one of the reset points to return the graph to the normal view.

Changing Settings Over the Air
Within the Network Diagnostics application, you can view a device's current configuration and change the
following settings over the air:

l OperationMode

l Baud Rate

l Transmission Characters

l Multipoint Parameters
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Note: As of Tool Suite release 2.6.0, you can also change an Ethernet's settings over
the air.

Whenmaking changes, always start at the farthest site in the line, for example, the Slave farthest from the
Master.

1. Click Network Diagnostics in the Applications pane to display the Network Diagnostics
application.

2. In the Networks section of the Network Diagnostics ribbon, select the network that contains the
device you want to change.

3. In the Radio tree view, select the device you want to change.

4. Click theSettings tab at the bottom of the Network Diagnostics window to display the device's
current settings.

5. In the parameter field you want to change, make the necessary changes.

6. Right-click in the field to change and select Change.

7. AnswerYes at the prompt to continue orNo to exit without making any changes.

While the change is being sent to the device, a warning icon displays next to the field that is
changing.

The new value displays in the field and the warning icon no longer displays when the settings as
changed.

If the value does not show right away, try polling the radio tomake sure the setting was changed.
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Chapter 5: Local Diagnostics Application

The Local Diagnostics application presents a real-time snapshot of MultiPoint setups that measure the
signal -to-noise level of the device. This informationmay be read from a Slave, Repeater, or Slave/Repeater
device. Use local diagnostic information to help direct a directional antenna of a Slave device by tracking the
signal and noise levels as the antenna is aimed back at the Repeater or Master.

Note: To run Local Diagnostics youmust set the connected device’s Diagnostics
parameter (located in theMultiPoint Parameters tab in the Configuration
application) to a value greater than zero.

Click Local Diagnostics in the Application pane to get started.
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Running Local Diagnostics
The Local Diagnostics application presents a real-time snapshot of MultiPoint setups that measure the
signal-to-noise level of the device. It presents the data in both a graph form and with values in a table above
the graph.

To run a local diagnostic:

1. Click Local Diagnostics in the Applications pane to display the Local Diagnostics
application.

2. In thePort Speed field in the Local Diagnostics ribbon, select the speed of the port to which the
device is connected.

3. In theCom Port field in the Local Diagnostics ribbon, select the Com port to which the device is
connected.

4. Click Start in the Local Diagnostics ribbon to begin running the diagnostic.

To stop a local diagnostic:

1. Click Local Diagnostics in the Applications pane to display the Local Diagnostics
application.

2. Click Stop in the Local Diagnostics ribbon.

Printing Local Diagnostics
In Tool Suite version 2.4.0 and above, you can print the current view of the local diagnostics graph. 

1. Click Local Diagnostics in the Applications pane to display the Local Diagnostics
application.
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2. Click Print in the Local Diagnostics ribbon to display a print preview of the graph.

3. To print the graph, click the Printer icon in the upper left corner of the print preview window.

The document is sent to the default printer defined on your computer.
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Chapter 6: Spectrum Tool Application

The Spectrum Tool application puts a supported serial device into a listeningmode that monitors the ambient
noise at various spectrum points as the radio hops through them.

The Spectrum Tool application is only available for 900MHz, 2.4 GHz, and 1.3 GHz serial devices.

Click Spectrum Tool in the Applications pane to get started.
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Running a Spectrum Analysis
Use the Spectrum Tool to monitor the ambient noise at various spectrum points as the radio hops through
them.

Note: To run an analysis for a device, the devicemust be taken offline.

To run a spectrum analysis:

1. Click Spectrum Tool in the Applications pane to display the Spectrum Tool application.

2. Connect the device and click Start in the Spectrum Tool ribbon.

3. Click Yes at the prompt to place the device offline and run the analysis or click No to exit without
taking the device offline and running the analysis.

Tool Suite runs the analysis and updates the graph as it receives data from the device:

4. Click Reset Data in the Spectrum Tool ribbon to reset the peak and average trend lines in the
graph. 
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To stop a spectrum analysis:

1. Click Spectrum Tool in the Applications pane to display the Spectrum Tool application.

2. Click Stop in the Spectrum Tool ribbon.

Printing a Spectrum Analysis Graph
In Tool Suite version 2.4.0 and above, you can print the current view of the spectrum analysis graph.

1. Click Spectrum Tool in the Applications pane to display the Spectrum Tool application.

2. Click Print in the ribbon to display a print preview of the graph.

3. To print the graph, click thePrinter icon in the upper left corner of the print preview window.

The document is sent to the default printer defined on your computer.
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Chapter 7: Setup Terminal Application

Use the Setup Terminal application to configure a device using a terminal window that mirrors themenu
structure of HyperTerminal. You can use the Setup Terminal instead of the Configuration application to
program devices in your network.

Note: I/O Expansion Serial Base and Expansionmodules are not compatible with
either HyperTerminal or the Tool Suite Setup Terminal application. Configure
these devices using the parameters in the Configuration application. See "I/O
Serial Base and ExpansionModule Device Parameter Tabs" on page 31.

Click Setup Terminal in the Applications pane to get started.
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Configuring Devices Using Setup Terminal
Use the Setup Terminal application to configure a device using a terminal window that mirrors themenu
structure of HyperTerminal.

Note: All changes made through Setup Terminal are sent to the device immediately.

Be sure to disconnect the device after making any changes before running diagnostics for the device.

1. Click Setup Terminal in the Applications pane to display the Setup Terminal application.

2. Ensure the device you want to configure is connected to your computer and that all diagnostics are
stopped.

3. Select the Com Port to which the device is connected from the drop-down list in the Setup
Terminal ribbon and click Connect.

The setupmenu for the device displays in the Setup Terminal window:

4. Type the number of themenu you want to expand andmake updates as necessary.

5. Press Esc to exit themenu or click Disconnect in the Setup Terminal ribbon to disconnect the
device.
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Chapter 8: CP Data Logger Application

The CP Data Logger is an application that provides basic polling and reporting functions for FreeWave
Cathodic Protection RemoteMonitoring Units.

Click CP Data Logger in the Applications pane to get started.

Configuring CP Data Logger Network Settings
The first time you open the CP Data Logger application, you need to configure the settings for your Cathodic
Protection network. You can edit these settings later, if needed.
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1. Click CP Data Logger in the Applications pane to display the CP Data Logger application.

2. Click Settings in the Cathodic Protection ribbon to display the Network Settings window.

3. Click theNetwork tab and complete the following information:

Field Description

Name The name of the network to poll. Default displays as the name
until you change it.

Type Select the network type, Serial or TCP/IP. Complete the
additional settings in the last tab in the window.

High Impedance If the connected CP unit is a 2.4 GHz Sand High Impedance
device, select this check box.

Notes (Optional)Enter any notes up to 100 characters regarding the
network.

4. Click theModbus tab and complete the following information regarding theModbus settings for
the network:

Field Description

Address Length Select the length of theModbus address.The address length
must match the address length selected in the FGR-CP and
GX-CP devices.

Poll Timeout Enter the number of milliseconds between 100 and 5000, the
Master waits for a response from a poll.

The default and recommended value is 3000 (3000 = 3
seconds). The higher the number, the longer theMaster waits
before timing out (for example 5000 = 5 seconds).

Interval Timeout Enter the number of milliseconds between 50 and 300 the
Master waits between polling each site.

Instant
Off Repeats

Enter the number of times between 1 and 24 the Rectifier
Interrupt cycle is repeated.

Relay ON Delay Enter the number of seconds between 1 and 60 the relay is
turned on (disabling the rectifier).

Relay OFF Delay Enter the number of seconds between 1 and 60 the relay is
turned off (enabling the rectifier).

Charge Delay Enter the number of seconds between 1 and 200 to wait for the
measurement capacitors to charge.

5. If you are defining a serial network, click theSerial tab and complete the following information:

Field Description

Port Indicate which port on the computer is connected to
the device. For example, COM1.
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Field Description

Baud Rate Select the communication rate between the
computer and the device data port. The default Baud
Rate is 19200.

Parity Select the data parity of the network. The default
Parity is None.

Flow Control (RTS/CTS) Select this check box if the port uses standard
RTS/CTS control lines. The Flow Control check
box is typically not selected.

Important: TheBaud Rate, Parity, and Flow Controlmustmatch theMaster's
settings.

If you are defining a TCP/IP network, click the TCP tab and complete the following information:

Field Description

Terminal Address Enter the IP address of the terminal server through
which you connect to devices.

Terminal Port Enter the port number to which the serial Master is
connected.

6. Click OK to save the changes and close the Network Settings window, or click Cancel to exit
without saving changes.

Adding and Removing Cathodic Protection Sites
To add a Cathodic Protection (CP) device to your network, add a site. You can then group sites together that
have the same polling intervals and start times. For more information, see "Adding and Removing Cathodic
Protection Polling Groups" on page 77.

To add and configure a CP site:

1. Click CP Data Logger in the Applications pane to display the CP Data Logger application.

2. From theOptions drop-downmenu in the Network Title ribbon select Add Site.

The device is added to the Radios tree.

3. Click the Configuration tab at the bottom of the Data Logger window and set the following
information for the device:

Field Description

Name Enter a name that identifies the CP device.

New Site displays as the site name in the tree view until you
change the name in this field.
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Field Description

Coordinates Enter the global positioning system (GPS) coordinates of the
device. You can also enter notes in this field about the device's
location.

Shunt
Resistance

Enter the value of the shunt resistor.

Modbus ID Enter the sameModbus ID of the device.

Poll Interval and
Poll Start

Select how often the Data Logger collects data from the site and
enter the start time in thePoll Start field. If the site is part of a
group, the site uses the polling interval and start time defined for
the group.

l Hourly - Select to poll every hour. Set to start onminute 1
(:01) up tominute 59 (:59) of every hour.

l Daily - Select to poll once a day. Enter which hour to start
polling each day. Polling can be set to start on any hour from
1:00 AM to 11:00 PM.

l Weekly - Select to poll once a week. Set the initial day and
date the poller starts on the displayed calendar.  The poller
continues to poll each week on the specified day at midnight
(12:00 am).

l Monthly - Select to poll once amonth. Set the initial day and
date the poller begins for themonth.  The poller continues to
poll eachmonth on the specified date (for example, the 5th of
eachmonth) at midnight (12:00 am).

The interval you select displays under Polling in the group name
in the tree view.  For example, the following site is set to poll
hourly:

Enable Discrete
Output Pro-
gramming

Select this check box to activate theDiscrete Out button in the
Programming section of the Cathodic Protection ribbon.

For more information, see "Disconnecting the Cathodic
Protection Rectifier from the Pipe " on page 83.

Enable VSNS
Programming

Select this check box to activate theVSNS button in the
Programming section of the Cathodic Protection ribbon.
programming function.

For more information, see "Controlling Analog Sensor Power on
a Cathodic Protection Device " on page 83.

4. Click the icon in theActive field to activate or inactivate polling for all sites within the group.

l Active:
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l Inactive:

You can also right-click the group in the Radios tree and select the appropriate action.

Note: Activating or inactivating a single site within a group only inactivates that
specific site.

5. In the Alarms table, enter the lower and upper limits that you you want to be warned about during
polling. All alarms, or specific alarm settings within the table can be left blank. The table below lists
the recommended alarm values for each parameter:

Field Description

Analog Input Measured in VDC.

Low Limit:At or below 0

High limit:At or above 6

Rectifier Shunt Voltage Measured inmVDC

Low Limit:At or below -1.6

High Limit:At or above 1.6

Rectifier Voltage Measured inmVDC.

Set both low and high limits to an impossible range.

Pipe to Soil Measured inmVDC.

Low Limit:At or below -1.6

High Limit: At or above 1.6

Battery Voltage Measured in VDC.

Low Limit:At or below 5

High Limit: At or above 31

Temperature Measured in °C.

Low Limit:At or below -36

High Limit: At or above 76

To remove a CP site:

1. Click CP Data Logger in the Applications pane to display the CP Data Logger application.

2. In the Radio tree, right-click the device you want to delete and select Delete.

Tool Suite deletes the device and its polling data .

Adding and Removing Cathodic Protection Polling Groups
Use groups in the CP Data Logger to group devices together into sites that share the same polling interval.

To add a group to a CP network:

1. Click CP Data Logger in the Applications pane to display the CP Data Logger application.

2. From theOptions drop-downmenu in the Network Title ribbon select Add Group.
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3. Complete the following information about the group:

Field Description

Name Enter a name for the group that identifies its purpose.

New Group displays as the Group name in the tree view, until
you rename the group.

Description (Optional)Enter any notes up to 100 characters regarding the
group of CP devices.

Poll Interval and
Poll Start

Select how often the Data Logger collects data from the sites
in the group and enter the start time in thePoll Start field.

l Hourly - Select to poll every hour. Set to start onminute 1
(:01) up tominute 59 (:59) of every hour.

l Daily - Select to poll once a day. Enter which hour to start
polling each day. Polling can be set to start on any hour
from 1:00 AM to 11:00 PM.

l Weekly - Select to poll once a week. Set the initial day
and date the poller starts on the displayed calendar.  The
poller continues to poll each week on the specified day at
midnight (12:00 am).

l Monthly - Select to poll once amonth. Set the initial day
and date the poller begins for themonth.  The poller
continues to poll eachmonth on the specified date (for
example, the 5th of eachmonth) at midnight (12:00 am).

The interval you select displays under Polling in the group
name in the tree view.  For example, the following site is set
to poll hourly:

4. Click the icon in theActive field to activate or inactivate polling for all sites within the group.

l Active -

l Inactive -

You can also right-click the group in the Radios tree and select the appropriate action.

To remove a CP group:

1. Click CP Data Logger in the Applications pane to display the CP Data Logger application.

2. In the Radio tree, right-click the group you want to delete and select Delete.

Tool Suite deletes the group and all the devices within that group.
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To add a site to a group:

1. Click CP Data Logger in the Applications pane to display the CP Data Logger application.

2. In the Radios tree, select the radio you want to move and drag and drop it on top of the group icon
to which you want to add the device.

The device displays nested under the group.

Gathering Data from Cathodic Protection Sites
After you have configured a CP site, you can poll that site for data. If Tool Suite is connected to the site and
you have defined a recurring interval in thePolling Interval andPolling Start fields for the site, Tool Suite
polls the site at that interval for data.

1. Click CP Data Logger in the Applications pane to display the CP Data Logger application.

2. In the Radios tree, select the site or group you want to poll and click Connect in the Network
section of the Cathodic Protection ribbon.

3. If a graph does not display in the CP Data Logger window when you connect, click Read Latest to
populate the window with the view of a graph.

Click Read Latest again to populate the graph with the polled data.

Note: The status of the polling command is displayed at the bottom of the window.

4. As you are polling data from a site, you can also do the following using the options in the
Poll Command section of the ribbon.

l To force the radio to cycle relays, click Force Refresh to refresh themeasurements of the
charging capacitors.

l To cycle the rectifier one time, click Rectifier Interrupt to turn off the rectifier and go through
oneOn, Off, Charge relay cycle.

l To cycle the rectifier multiple times, click Perform Instant Off to cycle the rectifier through the
number of On, Off, and Charge relay cycles defined in theRectifier Interrupt field in the CP
network settings.

Viewing Cathodic Protection Polled Data
Tool Suite offers multiple ways to review the data returned when it polls a Cathodic Protection (CP) device.

l Graph view - Displays all the current data from the device in chart.

l Summary view - Provides themost recent polls and provides an overview of all the sites and
groups within the network on a single page in a table format.
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l History view - Displays at-a-glace a history of the parameters polled from a device and when the
data was gathered.

Using the Cathodic Protection Graph View
You can view the data from aCathodic Protection (CP) device in graph form. Tool Suite charts all the current
data for the device on a single graph. You can zoom in and out on different parts of the graph for greater
magnification.

To display the graph view:

1. Click CP Data Logger in the Applications pane to display the CP Data Logger application.

2. From the Radio tree , select the device you want to review.

3. Click thePoll Data tab at the bottom of the CP Data Logger window.

To zoom in and out in the graph:

1. With the graph displayed, hold down the left button on themouse at the uppermost or lowest point
of the area on the graph in which you want to zoom.

2. Drag themouse across the entire area on which you want to zoom.
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To zoom out, click theO in either the top upper left corner (controls zooming out at the Y-axis)
and/or the lower left corner (controls zooming out at the X-axis) of the graph.

Note: The number of times the graph was magnified equals the number of times you
need to click either one of the reset points to return the graph to the normal view.

Using the Cathodic Protection Summary View
The Summary view displays themost recent polls and provides an overview of all the sites and groups within
the network on a single page.

Note: If the Rectifier Input Status is on in the site, then theRectifier Input Power
Status check box is checked in the Summary View. You cannot change the
setting from this view.

To display the Summary view:

1. Click CP Data Logger in the Applications pane to display the CP Data Logger application.

2. From the Radio tree, select the device you want to review and click the Summary tab.

To print or save summary data:

1. Click CP Data Logger in the Applications pane to display the CP Data Logger application.

2. From the Radio tree view, right-click the device you want to review and select View Report.

3. In the fields provided, enter the date range you want to print or save data and click Report , or
click Cancel to exit without creating a report.

To create a report with themost recent data, select the date on which the last poll was completed.

The report displays in a separate window. Use the icons across the top of the report window to
print and save as PDF or an Excel file.
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Using the Cathodic Protection History View
The History view displays at-a-glance a history of the parameters polled from a device and when the data was
gathered. The History tab refreshes each time the device is polled. You can view the history data within Tool
Suite and send the history to a report, from which you can print or save for viewing inMicrosoft Excel or as a
PDF.

To display the History view:

1. Click CP Data Logger in the Applications pane to display the CP Data Logger application.

2. From the Radio tree , select the device you want to review.

3. Click theHistory tab at the bottom of the CP Data Logger window.

To print or save history data:

1. Click CP Data Logger in the Applications pane to display the CP Data Logger application.

2. From the Radio tree, right-click the device you want to review and select View Report.

3. Enter the Date Range for which you want to print or save history data and click Report, or
click Cancel to exit without creating a report.

The report displays in a separate window. Use the icons across the top of the report window to
print and save as PDF or an Excel file.
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Disconnecting the Cathodic Protection Rectifier from the Pipe
On FGR2-CP devices, you have further control of the Interrupter Relay Driver. For more detailed information
about programming the Discrete Output, see to theCathodic ProtectionManual Addendum available on the
FreeWaveWeb site and theUserManuals and Utilities CD.

Note: You can only control the Relay Digital Output on sites that have theEnable
Discrete Output Programming check box selected in the site's Configuration
tab.

1. Click CP Data Logger in the Applications pane to display the CP Data Logger application.

2. In the Radios tree, select the site you want to control.

3. Click Discrete Out in the Programming section of the Cathodic Protection ribbon and select On to
disconnect the rectifier from the pipe.

Controlling Analog Sensor Power on a Cathodic Protection Device
You have further control of the power to the analog sensor on a Cathodic Protection (CP) device. For more
detailed information about programming the Sensor Power, see theCathodic ProtectionManual Addendum
available on the FreeWaveWeb site and theUserManuals and Utilities CD.

Note: You can only control the analog sensor power on sites that have theEnable
VSNS Programming check box selected in the site's Configuration tab.

1. Click CP Data Logger in the Applications pane to display the CP Data Logger application.

2. In the Radios tree , select the site you want to control.

3. Click VSNS in the Programming section of the Cathodic Protection ribbon and select On to enable
the sensor power.
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Chapter 9: Modbus Interface Application

Use theModbus Interface application to validate and troubleshoot theModbus configuration for a device that
uses theModbus protocol. Using theModbus Interface application can help you to determine if a problem you
are experiencing is a hardware issue, a software issue, or an issue with a device to which a FreeWave device
is connected. From theModbus Interface application you can do the following:

l Use pre-entered register maps for all FreeWave I/O products.

l Poll andmonitor devices using the Dashboard, Summary view, or using a graphical chart.

l Import and export register maps.

l Edit and add register maps of your own.

Click Modbus Interface in the Applications pane to get started.
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About Monitoring Modbus Devices
Using theModbus Interface application, you can validate and troubleshoot specific registers to ensure a
device running theModbus protocol is functioning correctly. For information about selecting the registers you
want to monitor from your devices, see "Selecting Registers to Monitor" on page 88.

The application offers the following views into a device's register data.

l Dashboard - The Dashboard displays in theModbus Interfacemain window and contains the
Modbus ID, device name, register name, current register value, and the last updated information
for the registers that you selected tomonitor. For more information, see "Using theModbus
Interface Dashboard" on page 89.

l Summary View - The Summary view provides a high-level view of the registers you select to
monitor. For more information, see "Using theModbus Interface Summary View" on page 90.

l Chart View - The Chart view provides a graphic representation of the register's you select to
monitor. For more information, see "Using theModbus Interface Chart View" on page 91.

Configuring Modbus Network Settings
To connect Tool Suite to aModbus device for monitoring, youmust first define the characteristics of your
network.

1. Click Modbus Interface in the Applications pane to display theModbus Interface application.

2. Click Settings in theModbus Interface ribbon to display the Network Settings window.

3. Click the Network tab and provide the following identification information for the network:

l In theName field, enter a name that identifies the network.

l In the Type field, select what type of network you are defining, Serial or TCP.
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4. In theModbus tab, provide the following information about how often Tool Suite polls the devices in
the network for data:

Field Description

Poll Timeout Enter the number of milliseconds that Tool Suite
waits to receive a response from a device before
moving to the next device.

Interval Timeout Enter the number of milliseconds that Tool Suite
waits to receive a response from all devices prior to
timing out.

Poll Interval Enter the number of milliseconds that Tool Suite
waits between each polling cycle.This determines
how often the devices are polled.

5. If you are configuring a serial network, in the Serial tab provide the following information about the
serial port on the computer that is connected to the network you want to monitor:

Field Description

Port Indicate which port on the computer is connected to
the device. For example, COM1.

Baud Rate Select the communication rate between the
computer and the device data port. The default Baud
Rate is 19200.

Parity Select the data parity of the network. The default
Parity is None.

Flow Control (RTS/CTS) Select this check box if the port uses standard
RTS/CTS control lines. The Flow Control check
box is typically not selected.

If you are configuring a TCP network, in the TCP tab provide the following information about
connecting to the device:

Field Description

Terminal Address Enter the IP address of the terminal server through
which you connect to devices.

Terminal Port Enter the port number of the terminal server through
which you connect to devices.

6. Click OK to save the network setting and return to themainModbus Interface application window.

Adding and Removing Devices from Modbus Networks
Adding and removing devices from theModbus network works similarly to adding devices to a network in the
Configuration application.
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To add a device to a Modbus network:

1. Click Modbus Interface in the Applications pane to display theModbus Interface application.

2. Right-click in the Devices tab and select Add Device to display the New Device window.

3. Complete the following information for the device you are adding:

Field Description

Name A name that helps to identify the device.

Register Map The set of registers that Tool Suite can read from the
device. FreeWave provides register maps for the
FreeWave devices that run theModbus protocol.
You can also define your own register maps and
assign them to the device. For more information, see
"About Register Maps" on page 91.

Address Length Indicates if theModbus address is 8 bits or 16 bits
long, which also determines the range of acceptable
IDs. When reading FreeWave radios, this valuemust
match theModbus Address Size option of the
radio.

Modbus ID TheModbus identification number for the device. If
theAddress Length is 8 bit, theModbus ID can be
between 1 and 246. If theAddress Length is 16 bit,
the ID can be between 1 and 65535.

If you are unsure what theModbus ID is for a device,
connect to the device through the Configuration
application to look up theModbus ID assigned to the
device.

4. Click Add to add the device to the network, or click Cancel to exit without adding the device.

To remove a device from a Modbus network:

1. Click Modbus Interface in the Applications pane to display theModbus Interface application.

2. In the Default network portion of the window, click the Devices tab.

3. In the Device tab, right-click the device you want to remove and select Delete.

4. Click Yes at the prompt to delete the device, or click No to return to the Device tree without
deleting the device.

Selecting Registers to Monitor
A register map for a device can contain hundreds of registers. Out of all the registers in a device's register
map, youmight only be interested in a subset. You can add the individual registers you are interested in
monitoring to theModbus Interface Dashboard for polling andmonitoring.

1. Click Modbus Interface in the Applications pane to display theModbus Interface application.

2. In the Devices tab, click the device that you want to monitor to display its assigned register map.
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3. In the Registers table for the device, locate the register you want to monitor and click Add in the
far right column of the register line.

4. Repeat steps 2 and 3 for additional registers you want to monitor.

The register is added to the Dashboard at the bottom of the window. In addition, the register is also
added to the Summary view and the Chart view.

Connecting Modbus Devices for Monitoring
After you have defined your network settings, you can connect to aModbus device and beginmonitoring the
registers.

1. Click Modbus Interface in the Applications pane to display theModbus Interface application.

2. Ensure that the device is connected to power, that the device is connected to the correct port on
your computer, and that the network settings are correctly defined.

3. Click Connect in theModbus Interface ribbon.

The registers you selected to gather are collected and display automatically in the Dashboard,
Summary view, and Chart view. You can work in other parts of Tool Suite and the collection
process continues at the specified polling interval. However, you can only complete Tool Suite
tasks that do not require the port to which the device that you are polling is connected.

Changing Register Settings on Devices
As you are troubleshooting devices, you can change the setting for a register that you aremonitoring without
changing the register map. In doing so, you can determine if the device sends back the data you expect during
the next polling interval.

Note: You can only change values for registers that you have created. You cannot
modify the values of the registers in maps that FreeWave provides.

1. Click Modbus Interface in the Applications pane to display theModbus Interface application.

2. Ensure the registers you want to monitor are listed in the Dashboard at the bottom of the window.
See "Selecting Registers to Monitor" on page 88.

3. Connect the device you want to monitor, ensure the network settings are correct, and click
Connect in theModbus Interface ribbon to being polling the device.

As Tool Suite polls and receives information about the registers, the values returned are listed in
theValue field.

4. To change a value and send it to the device during the next polling cycle, right-click in theValue
field of the register you want to change and select Change.

5. In theNew Value field, enter the value to send to the device and click OK.

6. The next time Tool Suite communicates with the device, it sends the new value.

Using the Modbus Interface Dashboard
The Dashboard displays in theModbus Interfacemain window and contains theModbus ID, device name,
register name, current register value, and the last updated information for the register.
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To add registers to monitor to the dashboard, see See "Selecting Registers to Monitor" on page 88.

The Dashboard displays at the bottom of theModbus Interfacemain window. However, if you click in the
Dashboard title bar and drag your mouse, you can "float" the dashboard anywhere on your screen. To re-dock
it to the bottom of the application, click the title bar and drag your mouse cursor (while holding the title bar) to
the bottom arrow that displays.

You can also dock the dashboard to the right, left, or top of the Tool Suite window.

Using the Modbus Interface Summary View
The Summary view provides a high-level view of the registers you select to monitor. This view contains the
device name, register map assigned to the device, Modbus ID, register name, last value received from the
device, and the last time the device was polled. If Missed displays in theValue field, Tool Suite was unable to
gather the information for the register the last time it polled the device.

1. Click Modbus Interface in the Applications pane to display theModbus Interface application.

2. Ensure that Tool Suite is connect to andmonitoring a device.

3. In the Device tree, select the device you want to review and click the Summary tab.
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Using the Modbus Interface Chart View
You can view the data fromModbus polling in graph form. Tool Suite charts all the current data for the device
on a single graph. You can zoom in and out on different parts of the graph for greater magnification. The graph
contains the following data across the top of the graph.

To display the graph view:

1. Click Modbus Interface in the Applications pane to display theModbus Interface application.

2. In the Device tree , select the device you want to review.

3. Click theChart tab to display the graph.

To zoom in and out in the graph:

1. With the graph displayed, hold down the left button on themouse at the uppermost or lowest point
of the area on the graph in which you want to zoom.

2. Drag themouse across the entire area on which you want to zoom.

To zoom out, click theO in either the top upper left corner (controls zooming out at the Y-axis)
and/or the lower left corner (controls zooming out at the X-axis) of the graph.

Note: The number of times the graph was magnified equals the number of times you
need to click either one of the reset points to return the graph to the normal view.

About Register Maps
A register map includes all the points of data that you can read from a device. When you add a device to a
network, you assign it a register map so Tool Suite knows what data is available on the device and where the
data is stored in that device's memory.

FreeWave provides register maps in theModbus Interface application for the FreeWave devices that use the
Modbus protocol. You can also do the following:
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l Export a register map for use in Tool Suite on a different computer.

l Export a FreeWave register map and import it to create a unique version of themap. You cannot
edit themaps that FreeWave provides, however, you can edit an importedmap and assign the
editedmap to a device. Exporting a FreeWavemap and editing the imported version is themost
efficient way to create amap based on an existingmap that only has a few changes.

l Create a register map for third party devices that you aremonitoring using Tool Suite. Typically,
you have aModbus register map for the device that you can use to enter themap into Tool Suite.

Adding and Removing Modbus Register Maps
You can add your ownModbus register maps to assign to devices. For example, if you have a third-party
device that uses theModbus protocol, you can use theModbus Interface application within FreeWave Tool
Suite to monitor it as youmonitor other devices.

To add a Modbus register map:

1. Click Modbus Interface in the Applications pane to display theModbus Interface application.

2. Click Edit in theModbus Interface ribbon to display the Edit Register Maps window.

3. Click thePlus icon in the toolbar to display a blank register map.

4. In theName field, enter a name that identifies the purpose of theModbus register you are creating.

5. Select thePLC Addressing check box if the register map you are entering uses PLC addresses,
that is, the address locations in themap start at 1 instead of 0.

6. In the Register Map table, complete one row per register you want to create:

Field Description

Name Enter the register name.

Unit Enter the unit of measure, such as mV ormA. If a unit of
measure is not applicable, accept the default N/A value.

Modbus Type Select from the followingModbus types:

l Coil - Select this option if the register is a single bit.
l Input Register - Select this option if the register is a

read-only value.
l Holding Register - Select this option if the register is a

read/write value.

Value Type Select from one of the following values:

l 16-bit signed integer
l 16-bit unsigned integer
l 32-bit floating point (use this option for values that

contain decimals)
l 32-bit signed integer
l 32-bit unsigned integer
l Single bit
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Field Description

Address Enter the Register address of the value. For example,
40003.

Scale If you want to display the value in a different unit than is
returned from the device, enter the scale here. For example,
if the device returns mV but you prefer to view the value in
V, enter 0.001 in theScale field.

7. Click Close to save the register map and return to themainModbus Interface application window.

To remove a register map:

1. Click Modbus Interface in the Applications pane to display theModbus Interface application.

2. Click Edit in theModbus Interface ribbon to display the Edit Register Maps window.

3. Using the arrows in the toolbar, scroll through the register maps until you locate themap you want
to delete. 

The register map name displays in theName field. Names of the register maps that FreeWave
provides display in gray text. Register maps that you created or imported are listed at the end and
are displayed in black text.

4. With the correct register map displayed, click the red x icon in the toolbar and answerYes at
the prompt to delete the register map.

Editing Modbus Register Maps
You can edit the settings or add register items to amap that you created in theModbus Interface application.
You cannot edit the registers that FreeWave provides. However, you can export a FreeWave register map and
import it with a different name tomake a unique version of the register map

1. Click Modbus Interface in the Applications pane to display theModbus Interface application.

2. Click Edit in theModbus Interface ribbon to display the Edit Register Maps window.

3. Using the arrows in the toolbar, scroll through the register maps until you locate themap you want
to edit.

The register map name displays in theName field. Names of the register maps that FreeWave
provides display in gray text. Register maps that you created or imported are listed at the end and
display in black text.

4. With the correct register map displayed, add register items or update items as necessary. For
more information, see "Adding and RemovingModbus Register Maps" on page 92.

5. Click Close to save the register map and return to themainModbus Interface application window.

Exporting and Importing Modbus Register Maps
You can export the contents of a register map and import it back into your current instance of Tool Suite or
Tool Suite that runs on another computer. Youmight export and import register maps that you have created, or
export a map that FreeWave has provided, and import it in under a different name so you can edit the settings.
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To export a Modbus register map:

1. Click Modbus Interface in the Applications pane to display theModbus Interface application.

2. Click Edit in theModbus Interface ribbon to display the Edit Register Maps window.

3. Using the arrows in the toolbar, scroll through the register maps until you locate themap you want
to export.

4. With the correct map displayed, click theExport icon in the toolbar to display.

5. In the Export To window, select the directory in which you want to save the file.

6. In the File Name field, enter a file name that helps to identify the purpose of the register map.

All register maps exported from theModbus Interface are saved with a .rmx extension.

7. Click Save to export and save the file.

To import a Modbus register map:

1. Click Modbus Interface in the Applications pane to display theModbus Interface application.

2. Click Import in theModbus Interface ribbon.

3. In the Import Register Map window, locate the file with a .rmx extension that you want to import.

4. Click Open to import the register map file into theModbus Interface application.

The register map is now available for selection in theRegister Map field when you add a device to
your network.
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Chapter 10: Updates Application

Use the Update application to review themost recent Tool Suite updates available and to update your version
of the Tool Suite software.

From the Updates application you can do the following:

l Review the release notes for each upgrade version of the Tool Suite software. The Release Notes
include all the information about additions and changes in each release of the Tool Suite
application.

l Check to see if you are running the latest version of Tool Suite.

l Update to themost recent Tool Suite version.

Click Updates in the Applications pane to get started.

Note: After you have upgraded to version 2.8.5, any future upgrades make an
automatic backup copy of your ToolSuite.sdf (all Configuration application
data), ModPoller.sdf (all Modbus Interface data), and cprmu.sdf (all CP Data
Logger data) files in the the C:\Program Files\FreeWave
Technologies\Freewave Suite\backups directory.
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Updating Tool Suite at Program Startup
If you have an active Internet connection, when you start Tool Suite, it automatically connects to the
FreeWave network to determine if you are running the latest version of the software. If there is a new version
available, you are prompted about whether you want to update.

1. If a new update is available, when you open a Tool Suite session, a prompt displays informing you
that new updates are available.  To download the update, click Yes to display the Updates
application.

To continue with Tool Suite without downloading the update, click No.

2. After the update downloads, Tool Suite prompts you to install the update. Click Apply Updates to
install the updates in the Updates Application ribbon.

Tool Suite installs the updates, and re-launches after the install is complete.

Updating Tool Suite From an Open Session
If you are currently running Tool Suite and want to install updates, review the release notes for the updates
listed in the Update application and follow the steps below.

1. Click Updates in the Applications pane to display the Updates application.

2. Click Check Updates in the Updates ribbon.

A prompt displays indicating whether there are updates available to install.
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3. If there are updates, click Yes to download the updates. Otherwise click No to exit without
downloading the update.

When the download process is complete amessage displays prompting you to apply the updates.

4. Click OK to close the prompt and click Apply Updates in the Updates ribbon.

Tool Suite applies the updates and re-launches after the install is complete.

Updating Tool Suite Locally
To update Tool Suite on computers that do not have an active Internet connection, download the latest
updates to a computer that has a network connection, and either distribute the installation file on a network
drive, on a CD, or a drive that you can take into the field or carry throughout the office.

1. From a computer with an Internet connection, download the latest Tool Suite update from the
FreeWaveWeb site at www.freewave.com.

2. Save the update file to a folder on a local or network drive, portable drive, or CD for access later.

3. After the update file has been saved (if the package has been saved to a jump drive or CD, make
sure the hardware is plugged into the computer or the CD with the update package is in the
computer’s CD-ROM), click Updates in the Application pane.

4. Click Local Update in the Updates ribbon.

Tool Suite opens the last folder that was accessed through the software. If you saved the update
file in a different location, navigate to the correct directory, select the update file, and click Open.

Tool Suite installs the updates, and re-launches after the install is complete.

Upgrading Tool Suite from Versions 2.0.1.2 and Earlier
Due to database changes, if upgrading from Tool Suite version 2.0.1.2 or earlier youmust merge your old
database with the new database format. Tool Suite databases from versions 2.0.1.2 and below are not
compatible with Tool Suite version 2.2 and above databases.

Note: Tool Suite versions 1.4.1 and below cannot upgrade to version 2.6 or above from
the Updates application. To upgrade to the latest version, first un-install Tool
Suite, then download the latest installer from the FreeWave customer support
Web site or theUserManuals and System Tools CD. 

1. Click Updates in the Applications pane to display the Updates application.

If your system requires updates, "New updates are now available, would you like to download?”
displays. 

2. Click Yes to continue with the update process.

3. Click OK at the prompt that displays after the updates download.

Another prompt displays asking tomerge databases.

97



Chapter 10: Updates Application

LUM0030AB Rev C

4. Do one of the following at themerge databases prompt:

l Click Yes to merge databases.

l Click No to upgrade Tool Suite without merging databases.

Important: If you select No and continue to upgrade Tool Suite, all previously saved
data will be lost after upgrade.

l Click Cancel to exit without completing the upgrade.

If you select Yes, a status box displays while the databases aremerging. Themerge can take
several minutes.

If you select No, Tool Suite restarts automatically.

After themerge is complete, Tool Suite restarts and then reloads automatically.
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